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Product Overview

Design and implement motor control algorithms

Motor Control Blockset provides reference examples and blocks for developing field-oriented control
algorithms for brushless motors. The examples show how to configure a controller model to generate
compact and fast C code for any target microcontroller (with Embedded Coder®). You can also use
the reference examples to generate algorithmic C code and driver code for specific motor control
kits.

The blockset includes Park and Clarke transforms, sliding mode and flux observers, a space-vector
generator, and other components for creating speed and torque controllers. You can automatically
tune controller gains based on specified bandwidth and phase margins for current and speed loops
(with Simulink® Control Design™).

The blockset lets you create an accurate motor model by providing tools for collecting data directly
from hardware and calculating motor parameters. You can use the parameterized motor model to test
your control algorithm in closed-loop simulations.
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Model Configuration Parameters
Update the configuration parameters for a Simulink model that you create, before simulating or
deploying the model to the controller.

In the Simulink window, click Hardware Settings in the HARDWARE tab to open the Configuration
Parameters dialog box and select the target hardware in the Hardware board field.

Solver Configuration
In the Solver tab of the Configuration Parameters dialog box, for a fixed-step discrete solver, type
auto in the Fixed-step size (fundamental sample time) field.

ADC Interface Configuration
If you connect analog inputs (current or voltage sensors) to the hardware board, configure the related
ADC parameters in the Configuration Parameters dialog box by using the following steps:

1 Open the Hardware Implementation tab.
2 Set the ADC clock prescaler and check the ADC clock frequency. Ensure that the displayed ADC

clock frequency is less than the maximum value specified in the device datasheet.

This example shows the ADC configuration for LAUNCHXL-F28379D board. The maximum operating
frequency of ADCCLK for TMS320F28379D targets is 50 MHz.

2 Model Configuration Parameters
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PWM Interface Configuration
If you connect PWM outputs from target device to the inverter, configure the related PWM
parameters in the Configuration Parameters dialog box by using the following steps:

1 Open the Hardware Implementation tab.
2 Set the ePWM clock divider to SYSCLKOUT/1.
3 Update the following PWM pin assignment fields.

ePWM pin settings Property
PWM1A pin assignment Gate pulse for Phase-A high-side transistor
PWM1B pin assignment Gate pulse for Phase-A low-side transistor
PWM2A pin assignment Gate pulse for Phase-B high-side transistor
PWM2B pin assignment Gate pulse for Phase-B low-side transistor
PWM3A pin assignment Gate pulse for Phase-C high-side transistor
PWM3B pin assignment Gate pulse for Phase-C low-side transistor

 Model Configuration Parameters
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Hall Sensor Interface Configuration
If you connect a Hall sensor to the hardware board, configure the related parameters in the
Configuration Parameters dialog box by using the following steps:

1 Open the Hardware Implementation tab.
2 Select the eCAP group under Hardware board settings > Target hardware resources.
3 Update the following ECAP pin assignment fields:

ECAP pin assignment field Field value
ECAP1 pin assignment Hall A
ECAP2 pin assignment Hall B
ECAP3 pin assignment Hall C

2 Model Configuration Parameters
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The following example shows the eCAP configuration for a Hall sensor connected to DRV8312 board
with a F28069 Piccolo MCU control card:

Quadrature Encoder Interface Configuration
If you connect a Quadrature Encoder sensor to the hardware board, configure the related parameters
in the Configuration Parameters dialog box by using the following steps:

1 Open the Hardware Implementation tab.
2 Select the eQEP group under Hardware board settings > Target hardware resources.
3 Update the following EQEP pin assignment fields:

EQEP pin assignment field Property
EQEP1A pin assignment Quadrature Encoder Channel A
EQEP1B pin assignment Quadrature Encoder Channel B
EQEP1I pin assignment Quadrature Encoder Index

The following example shows the eQEP configuration for a quadrature encoder sensor connected to a
LAUNCHXL-F28379D board:

 Model Configuration Parameters
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Serial Communication Interface Configuration
If you are generating code and using serial communication between host and target Simulink models,
configure the related parameters in the Configuration Parameters dialog box by using the following
steps:

1 Open the Hardware Implementation tab.
2 Select the SCI_A group under Hardware board settings > Target hardware resources.
3 Update the following SCI_A settings:

SCI_A settings Property
Suspension mode Serial suspension mode
Number of stop bits Stop bits
Parity mode Parity

2 Model Configuration Parameters
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SCI_A settings Property
Character length bits Data bits
Desired baud rate in bits/sec Serial communication baud rate
Pin assignment(Tx) Output pin for Serial Transmit
Pin assignment(Rx) Input pin for Serial Receive

For example, use the following SCI_A configuration for a Hall sensor connected to a F28379D
LaunchPad board:

 Model Configuration Parameters
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Estimate Control Gains from Motor Parameters
Perform control parameter tuning for the speed and torque control loops that are part of the Field-
Oriented Control (FOC) algorithm. Motor Control Blockset provides you with multiple methods to
compute the control loop gains from the system or block transfer functions that are available for the
motors, inverter, and controller:

• Use the Field Oriented Control Autotuner block.
• Use Simulink Control Design.
• Use the model initialization script.

Field-Oriented Control Autotuner
The Field-Oriented Control Autotuner block of Motor Control Blockset enables you to automatically
tune the PID control loops in your Field-Oriented Control (FOC) application in real time. You can
automatically tune the PID controllers associated with the following loops (for more details, see
“Tune PID Controllers by Using Field-Oriented Control Autotuner”):

• Direct-axis (d-axis) current loop
• Quadrature-axis (q-axis) current loop
• Speed loop

For each loop that the block tunes, the Field-Oriented Control Autotuner block performs the
autotuning experiment in a closed-loop manner without using a parametric model associated with
that loop. The block enables you to specify the order in which the block tunes the control loops. When
the tuning experiment runs for one loop, the block has no effect on the other loops. For more details
about FOC autotuner, see Field Oriented Control Autotuner and “Tune PI controllers by Using Field
Oriented Control (FOC) Autotuner” on page 4-92

3 Estimate Control Gains from Motor Parameters
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Simulink Control Design
Simulink Control Design enables you to design and analyze the control systems modeled in Simulink.
You can automatically tune the arbitrary SISO and MIMO control architectures, including the PID
controllers. You can deploy PID autotuning to the embedded software to automatically compute the
PID gains in real time.

You can find the operating points and compute the exact linearizations of the Simulink models at
different operating conditions. Simulink Control Design provides tools that let you compute the
simulation-based frequency responses without modifying your model. For details, see https://
www.mathworks.com/help/slcontrol/index.html

Model Initialization Script
This section explains how the Motor Control Blockset examples estimate the control gains needed to
implement field-oriented control. For example, for a PMSM that is connected to a quadrature
encoder, these steps describe the procedure to compute the control loop gain values from the system
details by using the initialization script:

1 Open the initialization script (.m) file of the example in the MATLAB® window. When you run an
example, use the following steps to find the associated script file name:

a Select Modeling > Model Settings > Model Properties to open the model properties
window.

b In the Model Properties dialog box, navigate to the Callbacks tab > InitFcn to find the
name of the script file that Simulink launches before running the example.

 Estimate Control Gains from Motor Parameters
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2 This figure shows an example of the initialization script (.m) file:
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3 Use the Workspace to edit the control variables values. For example, to update Stator resistance
(Rs), use the variable pmsm to add the parameter value to the Rs field.

4 The model initialization script associated with a target model calls these functions and sets up
the workspace with the necessary variables:

3 Estimate Control Gains from Motor Parameters
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Model initialization script Function called by model
initialization script

Details

Script associated with a
target model

mcb_SetPMSMMotorParame
ters

Input to the function is motor
type (for example, BLY171D).

The function populates a
structure named pmsm in the
MATLAB workspace, which is
used by the model.

It also computes the
permanent magnet flux and
rated torque for the selected
motor.

You can extend the function
by adding an additional
"switch-case" for a new
motor.

This function also loads the
structure motorParam,
obtained by running
parameter estimation, to the
structure pmsm. If the
structure motorParam is not
available in the MATLAB
workspace, the function
loads the default parameters.

mcb_SetInverterParamet
ers

Input to the function is
inverter type (for example,
BoostXL-DRV8305).

The function populates a
structure named inverter in
the MATLAB workspace,
which is used by the model.

The function also computes
the inverter resistance for
the selected inverter.

You can extend the function
by adding an additional
"switch-case" for a new
inverter.

 Estimate Control Gains from Motor Parameters
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Model initialization script Function called by model
initialization script

Details

mcb_SetProcessorDetail
s

Inputs to the function are
processor type (for example,
F28379D) and the desired
PWM switching frequency.

The function populates a
structure named target in the
MATLAB workspace, which is
used by the model.

The function also computes
the PWM counter period that
is a parameter for the ePWM
block in the target model.

You can extend the function
by adding an additional
"switch-case" for a new
processor.

mcb_getBaseSpeed Inputs to the function are
motor and inverter
parameters.

The function computes the
base speed for PMSM.

Type help
mcb_getBaseSpeed at the
MATLAB command window
for more details.

mcb_SetPUSystem Inputs to the function are
motor and inverter
parameters.

The function sets the base
values of the per-unit system
for voltage, current, speed,
torque, and power.

The function populates a
structure named PU_System
in the MATLAB workspace,
which is used by the model.

3 Estimate Control Gains from Motor Parameters
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Model initialization script Function called by model
initialization script

Details

mcb.internal.SetContro
llerParameters

Inputs to the function are
motor and inverter
parameters, per-unit system
base values, PWM switching
time period, sample time for
the control system, and
sample time for the speed
controller.

The function computes the PI
parameters (Kp, Ki) for the
field-oriented control
implementation.

The function populates a
structure named PI_params
in the MATLAB workspace,
which is used by the model.

Type help
mcb.internal.SetContro
llerParameters at the
MATLAB command window
for more details.

This table explains the useful variables for each control parameter that you can update:

Note You can try starting MATLAB in the administrator mode on Windows® system, if you are unable
to update the model initialization scripts associated with the example models.

Control parameter category Control parameter name MATLAB Workspace Variable
Motor parameters Manufacturer’s model number pmsm.model

Manufacturer’s serial number pmsm.sn
Pole pairs pmsm.p
Stator resistance (Ohm) pmsm.Rs
d-axis stator winding inductance
(Henry)

pmsm.Ld

q-axis stator winding inductance
(Henry)

pmsm.Lq

Back emf constant
(V_line(peak)/krpm)

pmsm.Ke

Motor Inertia (kg.m2) pmsm.J
Friction constant (N.m.s) pmsm.F
Permanent Magnet Flux (WB) pmsm.FluxPM

 Estimate Control Gains from Motor Parameters

3-9



Control parameter category Control parameter name MATLAB Workspace Variable
Trated pmsm.T_rated
Nbase pmsm.N_base
Irated pmsm.I_rated

Position decoders QEP index and Hall position
offset correction

pmsm.PositionOffset

Quadrature encoder slits per
revolution

pmsm.QEPSlits

Inverter parameters Manufacturer’s model number inverter.model
Manufacturer’s serial number inverter.sn
DC link voltage of the inverter
(V)

inverter.V_dc

Maximum measurable currents
by ADCs (A)

inverter.I_max

Maximum permissible currents
by inverter (A)

inverter.I_trip

On-state resistance of MOSFETs
(Ohm)

inverter.Rds_on

Shunt resistance for current
sensing (Ohm)

inverter.Rshunt

Per-phase board resistance seen
by motor (Ohm)

inverter.R_board

Current scaling inverter.MaxADCCnt
ADC Offsets for current sensor
(Ia and Ib)

inverter.CtSensAOffset

inverter.CtSensBOffset
Enable Auto-calibration for
current sense ADCs

inverter.ADCOffsetCalibEnable

Processor Manufacturer’s model number target.model
Manufacturer’s serial number target.sn
CPU Frequency target.CPU_frequency
PWM frequency target.PWM_frequency
PWM counter period target.PWM_Counter_Period

Per-Unit System Base voltage (V) PU_System.V_base
Base current (A) PU_System.I_base
Base speed (rpm) PU_System.N_base
Base torque (Nm) PU_System.T_base
Base power (Watts) PU_System.P_base

Data-type for target device Data-type (Fixed-point Or
Floating-point) selection

dataType

3 Estimate Control Gains from Motor Parameters
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Control parameter category Control parameter name MATLAB Workspace Variable
Sample time values Switching frequency for

converter
PWM_frequency

PWM switching time period T_pwm
Sample time for current
controllers

Ts

Sample time for speed
controller

Ts_speed

Simulation sample time Ts_simulink
Simulation sample time for
motor

Ts_motor

Simulation sample time for
inverter

Ts_inverter

Controller parameters Proportional gain for Iq
controller

PI_params.Kp_i

Integral gain for Iq controller PI_params.Ki_i
Proportional gain for Id
controller

PI_params.Kp_id

Integral gain for Id controller PI_params.Ki_id
Proportional gain for Speed
controller

PI_params.Kp_speed

Integral gain for Speed
controller

PI_params.Ki_speed

Proportional gain for Field
weakening controller

PI_params.Kp_fwc

Integral gain for Field
weakening controller

PI_params.Ki_fwc

Note For the pre-defined processors and drivers, the model initialization script uses the default
values.

The model initialization script uses these functions for performing the computations:

Control parameter category Function Functionality
Base speed of the motor mcb_getBaseSpeed Calculates the base speed of

PMSM at the rated voltage and
rated load.

For details, type help
mcb_getBaseSpeed at the
MATLAB command prompt.
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Control parameter category Function Functionality
Motor characteristics for the
given motor and inverter

mcb_getCharacteristics Obtain these characteristics of
the motor.

• Torque vs speed
characteristics

• Power vs speed
characteristics

• Iq vs speed and Id vs speed
characteristics

For details, type help
mcb_getCharacteristics at
the MATLAB command prompt.

Control algorithm parameters mcb.internal.SetControll
erParameters

Compute the gains for these PI
controllers:

• Current (torque) control loop
gains (Kp, Ki), for currents Id
and Iq

• Speed control loop gains (Kp,
Ki)

• Field weakening control
gains (Kp, Ki)

For details, type help
mcb.internal.SetControll
erParameters at the MATLAB
command prompt.

Control analysis for the motor
and inverter you are using

mcb_getControlAnalysis Performs frequency domain
analysis for the computed gains
of PI controllers used in the
field-oriented motor control
system.

Note  This feature requires
Control System Toolbox™.

For details, type help
mcb_getControlAnalysis at
the MATLAB command prompt.

Obtain Base Speed

The function mcb_getBaseSpeed computes the base speed of the PMSM at the given supply voltage.
The function calculates the base speed of the PMSM at the rated voltage and rated load, which helps
you to develop the control algorithm for the motor.
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When you call this function (for example, base_speed = mcb_getBaseSpeed(pmsm,inverter)),
it returns the base speed for the given combination of PMSM and inverter. The function accepts the
following inputs:

• PMSM parameter structure.
• Inverter parameter structure.

These equations describe the computations that the function performs:

Imax
2 =   Id_max 

2 +   Iq_max
2

Vmax =  
vdc  

3   − RsImax

ωbase =  
 vmax

LqIq
2 + LdId + λm

2
       

where:

• Imax is the maximum phase current (Amperes).
• Id_max is the maximum d-axis phase current (Amperes).
• Iq_max is the maximum q-axis phase current (Amperes).
• vmax is the maximum line to neutral voltage (Volts).
• vdc is the dc voltage supplied to the inverter (Volts).
• Rs is the stator resistance (Ohms).
• ωbase is the base value of the rotor speed (Radians/ sec).
• Ld and Lq are the d-axis and q-axis stator winding inductances (Henry).
• Id and Iq are the d-axis and q-axis currents (Amperes).
• λm is the permanent magnet flux linkage (Weber).

Obtain Motor Characteristics

The function mcb_getCharacteristics calculates the torque and speed characteristics of the
motor, which helps you to develop the control algorithm for the motor.

The function returns the following characteristics the given PMSM:

• Torque vs Speed
• Power vs Speed
• Iq vs Speed
• Id vs Speed
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Obtain Controller Gains

The function mcb.internal.SetControllerParameters computes the gains for the PI controllers
used in the field-oriented motor control systems.

When you call this function (for example, PI_params =
mcb.internal.SetControllerParameters(pmsm,inverter,PU_System,T_pwm,Ts_control
,Ts_speed)), it returns the gains of these PI controllers used in the FOC algorithm:

• Direct-axis (d-axis) current loop
• Quadrature-axis (q-axis) current loop
• Speed loop
• Field-weakening control loop

The function accepts these inputs:

• pmsm object
• inverter object
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• PU system params
• T_pwm
• Ts_control
• Ts_speed

The function does not plot any characteristic.

The design of compensators depends on the classical frequency response analysis applied to the
motor control systems. We used the Modulus Optimum (MO) based design for the current controllers
and the Symmetrical Optimum (SO) based design for the speed controller.

The function automatically computes the other required parameters (for example, bandwidth,
damping) based on the input arguments.

Perform Control Analysis

The function mcb_getControlAnalysis performs the basic control analysis of the PMSM FOC
current control system. The function performs frequency domain analysis for the computed PI
controller gains used in the field-oriented motor control systems.

Note This function requires the Control System Toolbox.

When you call this function (for example,
mcb_getControlAnalysis(pmsm,inverter,PU_System,PI_params,Ts,Ts_speed)), it
performs the following functions for the current control loop or subsystem:

• Transfer function for the closed-loop current control system
• Root locus
• Bode diagram
• Stability margins (PM & GM)
• Step response
• PZ map

The function plots the corresponding plots:
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Implement Motor Speed Control by
Using Field-Oriented Control (FOC)

• “Implement Motor Speed Control Using Field-Oriented Control (FOC)” on page 4-2
• “Sensorless Field-Oriented Control of PMSM Using Sliding Mode Observer and Flux Observer”

on page 4-7
• “Field-Oriented Control of PMSM by Using Hall Sensor” on page 4-13
• “Field Oriented Control of PMSM by Using Quadrature Encoder” on page 4-20
• “Field Weakening Control (with MTPA) of PMSM” on page 4-27
• “Hall Offset Calibration for PMSM Motor” on page 4-39
• “Quadrature Encoder Offset Calibration for PMSM Motor” on page 4-45
• “Run 3-Phase AC Motors in Open-loop Control and Calibrate ADC Offset” on page 4-52
• “Control Parameter Gain Tuning (Manual) in Hardware and Plant Validation” on page 4-62
• “Monitoring Resolver Using Serial Communication” on page 4-71
• “Field Oriented Control of PMSM by Using SI Units” on page 4-76
• “Modeling Switching Dynamics in the Inverter by using Simscape Electrical” on page 4-81
• “Tune PI controllers by Using Field Oriented Control (FOC) Autotuner” on page 4-92
• “Use Motor Control Blockset™ to Generate Code for a Custom Target” on page 4-94
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Implement Motor Speed Control Using Field-Oriented Control
(FOC)

Field-Oriented Control (FOC), also known as vector control, is a technique used to control Permanent
Magnet Synchronous Motor (PMSM) motors. FOC provides good control capability over the full
torque and speed ranges. The FOC implementation requires transformation of stator currents from
the stationary reference frame to the rotor flux reference frame (also known as d-q reference frame).

Speed control and torque control are the most commonly used control modes of FOC. The position
control mode is less common. Most of the traction applications use the torque control mode in which
the motor control system follows a reference torque value. In the speed control mode, the motor
controller follows a reference speed value and generates a torque reference for the torque control
that forms an inner subsystem. In the position control mode, the speed controller forms the inner
subsystem.

FOC algorithm implementation requires real time feedback of the currents and rotor position.
Measure the current and position by using sensors. You can also use sensorless techniques that use
the estimated feedback values instead of the actual sensor-based measurements.

This figure shows the Field-Oriented Control architecture for PMSM.

This example implements the Field-Oriented Control technique to control the speed of a three-phase
Permanent Magnet Synchronous Motor (PMSM). Field-Oriented Control (FOC), also known as vector
control, is a technique used to control a PMSM to provide good control capability over the full torque
and speed ranges. The FOC implementation requires transformation of stator currents from the
stationary reference frame to the rotor flux reference frame. You also need real-time feedback of the
rotor position to implement an FOC algorithm. You can measure the position feedback value by using
either a sensor-based or sensorless approach.
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This example uses the sensorless position estimation technique. You can select either the sliding
mode observer or the flux observer to estimate the position feedback for the FOC algorithm used in
the example.

The Sliding Mode Observer (SMO) block generates a sliding motion on the error between the
measured and estimated position. The block produces an estimated value that is closely proportional
to the measured position. The block uses stator voltages (Vα, Vβ) and currents (Iα, Iβ) as inputs and
estimates the electromotive force (emf) of the motor model. It uses the emf to further estimate the
rotor position and rotor speed. The Flux Observer block uses identical inputs (Vα, Vβ, Iα, Iβ) to
estimate the stator flux, generated torque, and the rotor position.

Models
We provide these models to implement sensorless FOC for PMSM:

• mcb_pmsm_foc_sensorless_f28069MLaunchPad
• mcb_pmsm_foc_sensorless_f28379d

You can use these models for both simulation and code generation. You can use the "open_system"
command to open a model. For example, use this command for a F28069M based controller:

open_system('mcb_pmsm_foc_sensorless_f28069MLaunchPad.slx');

For the model names that you can use for different hardware configurations, see the Required
Hardware topic in the Generate Code and Deploy Model to Target Hardware section.

Required MathWorks Products
• To simulate model:

1 For the model: mcb_pmsm_foc_sensorless_f28069MLaunchPad
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• Motor Control Blockset
• Fixed-Point Designer™

2 For the model: mcb_pmsm_foc_sensorless_f28379d

• Motor Control Blockset
• To generate code and deploy model:

1 For the model: mcb_pmsm_foc_sensorless_f28069MLaunchPad

• Motor Control Blockset
• Embedded Coder
• Embedded Coder Support Package for Texas Instruments™ C2000™ Processors
• Fixed-Point Designer

2 For the model: mcb_pmsm_foc_sensorless_f28379d

• Motor Control Blockset
• Embedded Coder
• Embedded Coder Support Package for Texas Instruments C2000 Processors
• Fixed-Point Designer (only needed for optimized code generation)

Prerequisites
1 Obtain the motor parameters. We provide default motor parameters with the Simulink model that

you can replace with the values from either the motor datasheet or other sources.

However, if you have the motor control hardware, you can estimate the parameters for the motor
that you want to use, by using the Motor Control Blockset parameter estimation tool. For
instructions , see “Estimate Motor Parameters by Using Motor Control Blockset Parameter
Estimation Tool” on page 6-2

The parameter estimation tool updates the motorParam variable (in the MATLAB(R) workspace)
with the estimated motor parameters.

2 If you obtain the motor parameters from the datasheet or other sources, update the motor
parameters and inverter parameters in the model initialization script associated with the
Simulink models. For instructions to update the script, see “Estimate Control Gains from Motor
Parameters” on page 3-2.

If you use the parameter estimation tool, you can update the inverter parameters, but do not
update the motor parameters in the model initialization script. The script automatically extracts
motor parameters from the updated motorParam workspace variable.

Simulate Model
This example supports simulation. Follow these steps to simulate the model.

1 Open a model included with this example.
2 To simulate the model, click Run in the Simulation tab.
3 To view and analyze the simulation results, click Data Inspector in the Simulation tab.

4 Implement Motor Speed Control by Using Field-Oriented Control (FOC)

4-4



Generate Code and Deploy Model to Target Hardware
This section instructs you to generate code and run the FOC algorithm on the target hardware.

We provide a host and a target model. The host model is a user interface to the controller hardware
board. You can run the host model on the host computer. The pre requisite to use the host model is to
deploy the target model to the controller hardware board. The host model uses serial communication
to command the target Simulink model and run the motor in a closed-loop control.

Required Hardware

This example supports these hardware configurations. Use the target model name (highlighted in
bold) to open the model for the corresponding hardware configuration, from the MATLAB command
prompt.

• LAUNCHXL-F28069M controller + BOOSTXL-DRV8305 inverter:
mcb_pmsm_foc_sensorless_f28069MLaunchPad

• LAUNCHXL-F28379D controller + BOOSTXL-DRV8305 inverter:
mcb_pmsm_foc_sensorless_f28379d

For connections related to the preceding hardware configurations, see “LAUNCHXL-F28069M and
LAUNCHXL-F28379D configurations” on page 8-5

Generate Code and Run Model on Target Hardware

1 Simulate the target model and observe the simulation results.
2 Complete the hardware connections.
3 The model automatically computes the Analog-to-Digital Converter (ADC) or current offset

values. To disable this functionality (enabled by default), update the value 0 to the variable
inverter.ADCOffsetCalibEnable in the model initialization script.

Alternatively, you can compute the ADC offset values and update it manually in the model
initialization scripts. For instructions to compute the ADC offset, see “Run 3-Phase AC Motors in
Open-loop Control and Calibrate ADC Offset” on page 4-52.

4 Open the target model for the hardware configuration that you want to use. If you want to
change the default hardware configuration settings for the model, see “Model Configuration
Parameters” on page 2-2.

5 Load a sample program to CPU2 of LAUNCHXL-F28379D, for example, a program that operates
the CPU2 blue LED by using GPIO31 (c28379D_cpu2_blink.slx), to ensure that CPU2 is not
mistakenly configured to use the board peripherals intended for CPU1.

6 Click Build, Deploy & Start in the Hardware tab to deploy the target model to the hardware.
7 In the target model, click the host model hyperlink to open the associated host model. You can

also use the "open_system" command to open the host model. For example, use this command for
a F28069M based controller:

open_system('mcb_pmsm_foc_host_model_f28069m.slx');
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For details about the serial communication between the host and target models, see
“Communication between Host and Target” on page 7-2.

8 In the Host Serial Setup block mask of the host model, select a Port name.
9 Update the Reference Speed value in the host model.
10 Click Run in the Simulation tab to run the host model.
11 Change the Start / Stop Motor switch position to On, to start running the motor.

Note Do not run the motor (using this example) in the open-loop condition for a long time
duration. The motor may draw high currents and produce excessive heat.

12 Observe the debug signals from the RX subsystem, in the Time Scope of host model.

Note If you are using a F28379D based controller, you can also select the debug signals that you
want to monitor.
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Sensorless Field-Oriented Control of PMSM Using Sliding Mode
Observer and Flux Observer

This example implements the Field-Oriented Control (FOC) technique to control the speed of a three-
phase Permanent Magnet Synchronous Motor (PMSM). For details about implementing FOC, see
“Implement Motor Speed Control Using Field-Oriented Control (FOC)” on page 4-2.

This example uses the sensorless position estimation technique. You can select either the sliding
mode observer or flux observer to estimate the position feedback for the FOC algorithm used in the
example.

The Sliding Mode Observer (SMO) block generates a sliding motion on the error between the
measured and estimated position. The block produces an estimated value that is closely proportional
to the measured position. The block uses stator voltages  and currents  as inputs and
estimates the electromotive force (emf) of the motor model. It uses the emf to further estimate the
rotor position and rotor speed. The Flux Observer block uses identical inputs  to
estimate the stator flux, generated torque, and the rotor position.

Models

The example includes these models:

• mcb_pmsm_foc_sensorless_f28069MLaunchPad

• mcb_pmsm_foc_sensorless_f28379d

You can use these models for both simulation and code generation. You can use the "open_system"
command to open a model. For example, use this command for a F28069M based controller:

open_system('mcb_pmsm_foc_sensorless_f28069MLaunchPad.slx');
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For the model names that you can use for different hardware configurations, see the Required
Hardware topic in the Generate Code and Deploy Model to Target Hardware section.

Required MathWorks® Products

To simulate model:

1. For the model: mcb_pmsm_foc_sensorless_f28069MLaunchPad

• Motor Control Blockset™
• Fixed-Point Designer™

2. For the model: mcb_pmsm_foc_sensorless_f28379d

• Motor Control Blockset™

To generate code and deploy model:

1. For the model: mcb_pmsm_foc_sensorless_f28069MLaunchPad

• Motor Control Blockset™
• Embedded Coder®
• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors
• Fixed-Point Designer™

2. For the model: mcb_pmsm_foc_sensorless_f28379d

• Motor Control Blockset™
• Embedded Coder®
• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors
• Fixed-Point Designer™ (only needed for optimized code generation)

Prerequisites

1. Obtain the motor parameters. We provide default motor parameters with the Simulink® model that
you can replace with the values from either the motor datasheet or other sources.

However, if you have the motor control hardware, you can estimate the parameters for the motor that
you want to use, by using the Motor Control Blockset parameter estimation tool. For instructions , see
“Estimate Motor Parameters by Using Motor Control Blockset Parameter Estimation Tool” on page 6-
2.

The parameter estimation tool updates the motorParam variable (in the MATLAB® workspace) with
the estimated motor parameters.

2. If you obtain the motor parameters from the datasheet or other sources, update the motor
parameters and inverter parameters in the model initialization script associated with the Simulink®
models. For instructions to update the script, see “Estimate Control Gains from Motor Parameters” on
page 3-2

If you use the parameter estimation tool, you can update the inverter parameters, but do not update
the motor parameters in the model initialization script. The script automatically extracts motor
parameters from the updated motorParam workspace variable.
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Simulate Model

This example supports simulation. Follow these steps to simulate the model.

1. Open a model included with this example.

2. To simulate the model, click Run in the Simulation tab.

3. To view and analyze the simulation results, click Data Inspector in the Simulation tab.

Generate Code and Deploy Model to Target Hardware

This section instructs you to generate code and run the FOC algorithm on the target hardware.

This example uses a host and a target model. The host model is a user interface to the controller
hardware board. You can run the host model on the host computer. The pre requisite to use the host
model is to deploy the target model to the controller hardware board. The host model uses serial
communication to command the target Simulink® model and run the motor in a closed-loop control.

Required Hardware

This example supports these hardware configurations. Use the target model name (highlighted in
bold) to open the model for the corresponding hardware configuration, from the MATLAB® command
prompt.

• LAUNCHXL-F28069M controller + BOOSTXL-DRV8305 inverter:
mcb_pmsm_foc_sensorless_f28069MLaunchPad

• LAUNCHXL-F28379D controller + BOOSTXL-DRV8305 inverter:
mcb_pmsm_foc_sensorless_f28379d

For connections related to the preceding hardware configurations, see “LAUNCHXL-F28069M and
LAUNCHXL-F28379D configurations” on page 8-5.

Generate Code and Run Model on Target Hardware

1. Simulate the target model and observe the simulation results.

2. Complete the hardware connections.

3. The model automatically computes the Analog-to-Digital Converter (ADC) or current offset values.
To disable this functionality (enabled by default), update the value 0 to the variable
inverter.ADCOffsetCalibEnable in the model initialization script.

Alternatively, you can compute the ADC offset values and update it manually in the model
initialization scripts. For instructions to compute the ADC offset, see “Run 3-Phase AC Motors in
Open-loop Control and Calibrate ADC Offset” on page 4-52.

4. Open the target model for the hardware configuration that you want to use. If you want to change
the default hardware configuration settings for the model, see “Model Configuration Parameters” on
page 2-2.

5. Load a sample program to CPU2 of LAUNCHXL-F28379D, for example, program that operates the
CPU2 blue LED using GPIO31 (c28379D_cpu2_blink.slx), to ensure that CPU2 is not mistakenly
configured to use the board peripherals intended for CPU1.
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6. Click Build, Deploy & Start in the Hardware tab to deploy the target model to the hardware.

7. In the target model, click the host model hyperlink to open the associated host model. You can
also use the "open_system" command to open the host model. For example, use this command for a
F28069M based controller:

open_system('mcb_pmsm_foc_host_model_f28069m.slx');
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For details about the serial communication between the host and target models, see “Communication
between Host and Target” on page 7-2

8. In the Host Serial Setup block mask of the host model, select a Port name.

9. Update the Reference Speed value in the host model.

10. Click Run in the Simulation tab to run the host model.

11. Change the Start / Stop Motor switch position to On, to start running the motor in the open-loop
condition (by default, the motor spins at 10% of base speed).

Note: Do not run the motor (using this example) in the open-loop condition for a long time duration.
The motor may draw high currents and produce excessive heat.

We designed the open-loop control to run the motor with a Reference Speed that is less than or equal
to 10% of base speed.

12. Increase the motor Reference Speed beyond 10% of base speed to switch from open-loop to
closed-loop control.

NOTE: To change the motor's direction of rotation, reduce the motor Reference Speed to a value less
than 10% of the base speed. This brings the motor back to open-loop condition. Change the direction
of rotation but keep the Reference Speed magnitude as constant. Afterwards, transition to the closed-
loop condition.

13. Observe the debug signals from the RX subsystem, in the Time Scope of host model.

Note: If you are using a F28379D based controller, you can also select the debug signals that you
want to monitor.
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Field-Oriented Control of PMSM by Using Hall Sensor
This example implements the Field-Oriented Control (FOC) technique to control the speed of a three-
phase Permanent Magnet Synchronous Motor (PMSM). The FOC algorithm requires rotor position
feedback, which is obtained by a Hall sensor. For details about implementing FOC, see “Implement
Motor Speed Control Using Field-Oriented Control (FOC)” on page 4-2.

This example uses the Hall sensor to measure the rotor position. A Hall effect sensor varies its output
voltage based on the strength of the applied magnetic field. A Hall sensor identifies the rotor position
by detecting the polarity of the rotor magnets. A PMSM consists of three Hall sensors located
electrically 120 degrees apart. A PMSM with this setup can provide six combinations valid of binary
states (for example, 001,010,011,100,101, and 110). The sensor provides the angular position of the
rotor in the multiples of 60 degrees, which the controller uses to compute the angular velocity. The
controller can then use the angular velocity to compute an accurate angular position of the rotor.

Models

The example includes these models:

• mcb_pmsm_foc_hall_f28069m

• mcb_pmsm_foc_hall_f28379d

You can use these models for both simulation and code generation. You can use the "open_system"
command to open the Simulink® model. For example, use this command for a F28069M based
controller:

open_system('mcb_pmsm_foc_hall_f28069m.slx');
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For the model names that you can use for different hardware configurations, see the Required
Hardware topic in the Generate Code and Deploy Model to Target Hardware section.

Required MathWorks® Products

To simulate model:

1. For the model: mcb_pmsm_foc_hall_f28069m

• Motor Control Blockset™
• Fixed-Point Designer™

2. For the model: mcb_pmsm_foc_hall_f28379d

• Motor Control Blockset™

To generate code and deploy model:

1. For the model: mcb_pmsm_foc_hall_f28069m

• Motor Control Blockset™
• Embedded Coder®
• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors
• Fixed-Point Designer™

2. For the model: mcb_pmsm_foc_hall_f28379d

• Motor Control Blockset™
• Embedded Coder®
• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors
• Fixed-Point Designer™ (only needed for optimized code generation)

Prerequisites

1. Obtain the motor parameters. We provide default motor parameters with the Simulink® model that
you can replace with the values from either the motor datasheet or other sources.
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However, if you have the motor control hardware, you can estimate the parameters for the motor that
you want to use, by using the Motor Control Blockset parameter estimation tool. For instructions , see
“Estimate Motor Parameters by Using Motor Control Blockset Parameter Estimation Tool” on page 6-
2.

The parameter estimation tool updates the motorParam variable (in the MATLAB® workspace) with
the estimated motor parameters.

2. If you obtain the motor parameters from the datasheet or other sources, update the motor
parameters and inverter parameters in the model initialization script associated with the Simulink®
models. For instructions to update the script, see “Estimate Control Gains from Motor Parameters” on
page 3-2.

If you use the parameter estimation tool, you can update the inverter parameters, but do not update
the motor parameters in the model initialization script. The script automatically extracts motor
parameters from the updated motorParam workspace variable.

Simulate Model

This example supports simulation. Follow these steps to simulate the model.

1. Open a model included with this example.

2. To simulate the model, click Run in the Simulation tab.

3. To view and analyze the simulation results, click Data Inspector in the Simulation tab.

Generate Code and Deploy Model to Target Hardware

This section instructs you to generate code and run the FOC algorithm on the target hardware.

This example uses a host and a target model. The host model is a user interface to the controller
hardware board. You can run the host model on the host computer. The pre requisite to use the host
model is to deploy the target model to the controller hardware board. The host model uses serial
communication to command the target Simulink® model and run the motor in a closed-loop control.

Required Hardware

This example supports these hardware configurations. Use the target model name (highlighted in
bold) to open the model for the corresponding hardware configuration, from the MATLAB® command
prompt.

• F28069M controller card + DRV8312-69M-KIT inverter: mcb_pmsm_foc_hall_f28069m

For connections related to the preceding hardware configuration, see “F28069 control card
configuration” on page 8-2.

• LAUNCHXL-F28069M controller + BOOSTXL-DRV8305 inverter: mcb_pmsm_foc_hall_f28069m

• LAUNCHXL-F28379D controller + BOOSTXL-DRV8305 inverter: mcb_pmsm_foc_hall_f28379d

For connections related to the preceding hardware configurations, see “LAUNCHXL-F28069M and
LAUNCHXL-F28379D configurations” on page 8-5.

Generate Code and Run Model on Target Hardware
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1. Simulate the target model and observe the simulation results.

2. Complete the hardware connections.

3. The model automatically computes the Analog-to-Digital Converter (ADC) or current offset values.
To disable this functionality (enabled by default), update the value 0 to the variable
inverter.ADCOffsetCalibEnable in the model initialization script.

Alternatively, you can compute the ADC offset values and update it manually in the model
initialization scripts. For instructions to compute the ADC offset, see “Run 3-Phase AC Motors in
Open-loop Control and Calibrate ADC Offset” on page 4-52.

4. Compute the Hall sensor offset value and update it in the model initialization script associated with
the target model. For instructions, see “Hall Offset Calibration for PMSM Motor” on page 4-39

5. Open the target model for the hardware configuration that you want to use. If you want to change
the default hardware configuration settings for the model, see “Model Configuration Parameters” on
page 2-2.

6. Load a sample program to CPU2 of LAUNCHXL-F28379D, for example, program that operates the
CPU2 blue LED by using GPIO31 (c28379D_cpu2_blink.slx), to ensure that CPU2 is not mistakenly
configured to use the board peripherals intended for CPU1.

7. Click Build, Deploy & Start in the Hardware tab to deploy the model to the hardware.

8. In the target model, click the host model hyperlink to open the associated host model. You can
also use the "open_system" command to open the host model. For example, use this command for a
F28069M based controller:

open_system('mcb_pmsm_foc_host_model_f28069m.slx');
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For details about the serial communication between the host and target models, see “Communication
between Host and Target” on page 7-2.

9. In the Host Serial Setup block mask of the host model, select a Port name.

10. Update the Reference Speed value in the host model.

11. Click Run in the Simulation tab to run the host model.

12. Change the Start / Stop Motor switch position to On, to start running the motor.

13. Observe the debug signals from the RX subsystem, in the Time Scope of host model.

Note: If you are using a F28379D based controller, you can also select the debug signals that you
want to monitor.
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Field Oriented Control of PMSM by Using Quadrature Encoder
This example implements the Field-Oriented Control (FOC) technique to control the speed of a three-
phase Permanent Magnet Synchronous Motor (PMSM). The FOC algorithm requires rotor position
feedback, which is obtained by a quadrature encoder sensor. For details about implementing FOC,
see “Implement Motor Speed Control Using Field-Oriented Control (FOC)” on page 4-2

This example uses the quadrature encoder sensor to measure the rotor position. The quadrature
encoder sensor consists of a disk with 2 tracks or channels that are coded ninety electrical degrees
out of phase. This creates two pulses (A and B) that have a phase difference of ninety degrees and an
index pulse (I). Therefore, the controller uses the phase relationship between A and B channels and
the transition of channel states to determine the direction of rotation of the motor.

Models

The example includes these models:

• mcb_pmsm_foc_qep_f28069m

• mcb_pmsm_foc_qep_f28069LaunchPad

• mcb_pmsm_foc_qep_f28379d

• mcb_pmsm_foc_qep_f28379d_GaN

You can use these models for both simulation and code generation. You can use the "open_system"
command to open the Simulink® model. For example, use this command for a F28069M based
controller:

open_system('mcb_pmsm_foc_qep_f28069m.slx');
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For the model names that you can use for different hardware configurations, see the Required
Hardware topic in the Generate Code and Deploy Model to Target Hardware section.

Required MathWorks® Products

To simulate model:

1. For the models: mcb_pmsm_foc_qep_f28069m and mcb_pmsm_foc_qep_f28069LaunchPad

• Motor Control Blockset™
• Fixed-Point Designer™

2. For the models: mcb_pmsm_foc_qep_f28379d and mcb_pmsm_foc_qep_f28379d_GaN

• Motor Control Blockset™

To generate code and deploy model:

1. For the models: mcb_pmsm_foc_qep_f28069m and mcb_pmsm_foc_qep_f28069LaunchPad

• Motor Control Blockset™
• Embedded Coder®
• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors
• Fixed-Point Designer™

2. For the models: mcb_pmsm_foc_qep_f28379d and mcb_pmsm_foc_qep_f28379d_GaN

• Motor Control Blockset™
• Embedded Coder®
• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors
• Fixed-Point Designer™ (only needed for optimized code generation)
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Prerequisites

1. Obtain the motor parameters. We provide default motor parameters with the Simulink® model that
you can replace with the values from either the motor datasheet or other sources.

However, if you have the motor control hardware, you can estimate the parameters for the motor that
you want to use, by using the Motor Control Blockset parameter estimation tool. For instructions , see
“Estimate Motor Parameters by Using Motor Control Blockset Parameter Estimation Tool” on page 6-
2.

The parameter estimation tool updates the motorParam variable (in the MATLAB® workspace) with
the estimated motor parameters.

2. If you obtain the motor parameters from the datasheet or other sources, update the motor
parameters and inverter parameters in the model initialization script associated with the Simulink®
models. For instructions to update the script, see “Estimate Control Gains from Motor Parameters” on
page 3-2

If you use the parameter estimation tool, you can update the inverter parameters, but do not update
the motor parameters in the model initialization script. The script automatically extracts motor
parameters from the updated motorParam workspace variable.

Simulate Model

This example supports simulation. Follow these steps to simulate the model.

1. Open a model included with this example.

2. Click Run in the Simulation tab to simulate the model.

3. Click Data Inspector in the Simulation tab to view and analyze the simulation results.

Generate Code and Deploy Model to Target Hardware

This section instructs you to generate code and run the FOC algorithm on the target hardware.

The example uses a host and a target model. The host model is a user interface to the controller
hardware board. You can run the host model on the host computer. The pre requisite to use the host
model is to deploy the target model to the controller hardware board. The host model uses serial
communication to command the target Simulink® model and run the motor in a closed-loop control.

Required Hardware

This example supports these hardware configurations. Use the target model name (highlighted in
bold) to open the model for the corresponding hardware configuration, from the MATLAB® command
prompt.

• F28069M control card + DRV8312-69M-KIT inverter: mcb_pmsm_foc_qep_f28069m

For connections related to the preceding hardware configuration, see “F28069 control card
configuration” on page 8-2.

• LAUNCHXL-F28069M controller + BOOSTXL-DRV8305 inverter:
mcb_pmsm_foc_qep_f28069LaunchPad
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• LAUNCHXL-F28379D controller + BOOSTXL-DRV8305 inverter: mcb_pmsm_foc_qep_f28379d

• LAUNCHXL-F28379D controller + BOOSTXL-3PHGANINV inverter:
mcb_pmsm_foc_qep_f28379d_GaN

NOTE: When using BOOSTXL-3PHGANINV inverter, ensure that proper insulation is available
between bottom layer of BOOSTXL-3PHGANINV and the LAUNCHXL board.

For connections related to the preceding hardware configurations, see “LAUNCHXL-F28069M and
LAUNCHXL-F28379D configurations” on page 8-5.

Generate Code and Run Model on Target Hardware

1. Simulate the target model and observe the simulation results.

2. Complete the hardware connections.

3. The model automatically computes the ADC (or current) offset values. To disable this functionality
(enabled by default), update the value 0 to the variable inverter.ADCOffsetCalibEnable in the model
initialization script.

Alternatively, you can compute the ADC offset values and update it manually in the model
initialization scripts. For instructions to compute the ADC offset, see “Run 3-Phase AC Motors in
Open-loop Control and Calibrate ADC Offset” on page 4-52.

4. Compute the quadrature encoder index offset value and update it in the model initialization scripts
associated with the target model. For instructions to compute the quadrature encoder offset, see
“Quadrature Encoder Offset Calibration for PMSM Motor” on page 4-45.

5. Open the target model for the hardware configuration that you want to use. If you want to change
the default hardware configuration settings for the model, see “Model Configuration Parameters” on
page 2-2.

6. Load a sample program to CPU2 of LAUNCHXL-F28379D, for example, program that operates the
CPU2 blue LED by using GPIO31 (c28379D_cpu2_blink.slx), to ensure that CPU2 is not mistakenly
configured to use the board peripherals intended for CPU1.

7. Click Build, Deploy & Start in the Hardware tab to deploy the target model to the hardware.

8. Click the host model hyperlink in the target model to open the associated host model. You can
also use the "open_system" command to open the host model. For example, use this command for a
F28069M based controller:

open_system('mcb_pmsm_foc_host_model_f28069m.slx');
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For details about the serial communication between the host and target models, see “Communication
between Host and Target” on page 7-2.

9. In the Host Serial Setup block mask of the host model, select a Port name.

10. Update the Reference Speed value in the host model.

11. Click Run in the Simulation tab to run the host model.

12. Change the Start / Stop Motor switch position to On, to start running the motor.

13. Observe the debug signals from the RX subsystem, in the Time Scope of host model.

Note: If you are using a F28379D based controller, you can also select the debug signals that you
want to monitor.
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Field Weakening Control (with MTPA) of PMSM
This example implements the Field Oriented Control (FOC) technique to control the torque and speed
of a three-phase Permanent Magnet Synchronous Motor (PMSM). The FOC algorithm requires rotor
position feedback, which is obtained by a quadrature encoder sensor. For details about implementing
FOC, see “Implement Motor Speed Control Using Field-Oriented Control (FOC)” on page 4-2.

Field Weakening Control

When you use the FOC algorithm to run a motor with rated flux, the maximum speed is limited by the
stator voltages, rated current, and back emf. This speed is called the base speed. Beyond this speed,
the operation of the machine is complex because the back emf is more than the supply voltage.
However, if you set the d-axis stator current (Id) to a negative value, the rotor flux linkage reduces,
which allows the motor to run above the base speed. This operation is known as field weakening
control of the motor.

Depending upon the connected load and rated current of the machine, the reference d-axis current
(Id) in the field weakening control also limits the reference q-axis current (Iq), and therefore, limits
the torque output. Therefore, the motor operates in the constant torque region until the base speed.
It operates in the constant power region with a limited torque above the base speed, as illustrated in
the preceding figure.

The computations for the reference current Id depend on the motor and inverter parameters.

Note:

 Field Weakening Control (with MTPA) of PMSM

4-27



• For some surface PMSMs, (depending upon the parameters) it may not be possible to achieve
higher speeds at the rated current. To achieve higher speeds, you need to overload the motor with
maximum currents that are higher than the rated current (if the thermal conditions of the
machine are within the permissible limits).

• When you operate the motor above the base speed, we recommended that you monitor the
temperature of the motor. During motor operation, if the motor temperature rises beyond the
temperature recommended by the manufacturer, turn-off the motor for safety reasons.

Maximum Torque Per Ampere (MTPA)

For the interior PMSMs, the saliency in the magnetic circuit of rotor results in higher  ratio (greater
than 1). This produces reluctance torque in the rotor (in addition to the existing electromagnetic
torque). For more information, see MTPA Control Reference.

Therefore, you can operate the machine at an optimum combination of  and , and obtain a higher

torque for the same stator current, .

This increases the efficiency of the machine, because the stator current losses are minimized. The
algorithm that you use to generate the reference  and  currents for producing maximum torque in
the machine, is called Maximum Torque Per Ampere (MTPA).
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For an Interior PMSM (IPMSM), the example computes the reference  and  currents using the
MTPA method until the base speed. For a Surface PMSM (SPMSM), the example achieves MTPA
operation by using a zero d-axis reference current, until the base speed.

To operate the motor above the base speed, the example computes the reference  and  for MTPA
and field-weakening control, depending upon the motor type. For a Surface PMSM, Constant Voltage
Constant Power (CVCP) control method is used. For an Interior PMSM, Voltage and Current Limited
Maximum Torque (VCLMT) control method is used.

For information related to MTPA Control Reference block, see MTPA Control Reference.

Target Communication
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For hardware implementation, this example uses a host and a target model. The host model, running
on the host computer, communicates with the target model deployed to the hardware connected to
the motor. The host model uses serial communication to command the target model and run the
motor in a closed-loop control.

Models

This examples uses multiple models for these hardware configurations:

Speed control of PMSM with field-weakening and MTPA:

• mcb_pmsm_fwc_qep_f28069LaunchPad

• mcb_pmsm_fwc_qep_f28379d

Torque control of PMSM with MTPA:

• mcb_pmsm_mtpa_qep_f28069LaunchPad

• mcb_pmsm_mtpa_qep_f28379d

You can use these models for both simulation and code generation. You can use the "open_system"
command to open the Simulink® model. For example, use this command for a F28069M based
controller:

open_system('mcb_pmsm_fwc_qep_f28069LaunchPad.slx');
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Required MathWorks® Products

To simulate model:

1. For the models: mcb_pmsm_fwc_qep_f28069LaunchPad and
mcb_pmsm_mtpa_qep_f28069LaunchPad

• Motor Control Blockset™
• Fixed-Point Designer™

2. For the models: mcb_pmsm_fwc_qep_f28379d and mcb_pmsm_mtpa_qep_f28379d

• Motor Control Blockset™

To generate code and deploy model:

1. For the models: mcb_pmsm_fwc_qep_f28069LaunchPad and
mcb_pmsm_mtpa_qep_f28069LaunchPad

• Motor Control Blockset™
• Embedded Coder®
• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors
• Fixed-Point Designer™

2. For the models: mcb_pmsm_fwc_qep_f28379d and mcb_pmsm_mtpa_qep_f28379d
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• Motor Control Blockset™
• Embedded Coder®
• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors
• Fixed-Point Designer™ (only needed for optimized code generation)

Prerequisites

1. Obtain the motor parameters. We provide default motor parameters with the Simulink® model that
you can replace with the values from either the motor datasheet or other sources.

However, if you have the motor control hardware, you can estimate the parameters for the motor that
you want to use, by using the Motor Control Blockset parameter estimation tool. For instructions , see
“Estimate Motor Parameters by Using Motor Control Blockset Parameter Estimation Tool” on page 6-
2.

The parameter estimation tool updates the motorParam variable (in the MATLAB® workspace) with
the estimated motor parameters.

2. If you obtain the motor parameters from the datasheet or other sources, update the motor,
inverter, and position sensor calibration parameters in the model initialization script associated with
the Simulink® models. For instructions to update the script, see “Estimate Control Gains from Motor
Parameters” on page 3-2

If you use the parameter estimation tool, you can update the inverter and position sensor calibration
parameters, but do not update the motor parameters in the model initialization script. The script
automatically extracts motor parameters from the updated motorParam workspace variable.

Simulate (Speed Control and Torque Control) Models

This example supports simulation. Follow these steps to simulate the model.

1. Open a model included with this example.

2. Click Run in the Simulation tab to simulate the model.

3. Click Data Inspector in the Simulation tab to view and analyze the simulation results.

Analyze simulation results for Speed Control Model

The model uses the per-unit system to represent speed, currents, voltages, torque, and power. Type
PU System at the workspace to see the conversion of one per-unit value into SI units for these
quantities.

Observe the dynamics of the system for the speed and current controllers. In addition, notice the
negative Id currents for motor operation above the base speed.
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Note:

For some surface PMSMs, (depending upon the parameters) it may not be possible to achieve higher
speeds at the rated current. To achieve higher speeds, you need to overload the motor with maximum
currents that are higher than the rated current (if the thermal conditions of the machine are within
the permissible limits).

When you operate the motor above the base speed, we recommended that you monitor the
temperature of motor. During motor operation, if the motor temperature rises beyond the
temperature recommended by the manufacturer, turn-off the motor for safety reasons.

Analyze simulation results for Torque Control Model

Run simulation with the Id and Iq reference currents generated by these three methods:

1. Generate reference currents by using the MTPA Control Reference Block.
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2. Generate the MTPA reference currents manually by using the Vector Control Reference Block.

3. Generate the Control Reference without MTPA.

The first method uses mathematical computations to determine the reference currents Id and Iq,
after assuming linear inductances.

Use the second method to manually generate the MTPA look-up tables for motors with non-linear
inductances. You can illustrate this with the Id and Iq references generated by sweeping the torque
angle between +(π/2) to -(π/2).

Use the last method to obtain the reference currents without the MTPA algorithm.

You can compare the torque and power generated by these three methods in the data inspector.
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In the preceding example, you can notice that the electrical torque generated using MTPA is 0.34PU
whereas electrical torque generated without MTPA is 0.27PU. You can also notice that with a varying
torque angle, the maximum generated torque matches the torque produced by MTPA. The negative d-
axis current indicates that the MTPA utilizes the reluctance torque for interior PMSM.

NOTE: If you are working with Surface PMSM, change the Type of motor parameter from Interior
PMSM to Surface PMSM, in the MTPA Control Reference block located at the location: "Torque
Control\MTPA_Reference\MTPA Control Reference."

Generate Code and Deploy Model to Target Hardware

This section instructs you to generate code and run the FOC algorithm on the target hardware.

The example uses a host and a target model. The host model is a user interface to the controller
hardware board. You can run the host model on the host computer. The pre requisite to use the host
model is to deploy the target model to the controller hardware board. The host model uses serial
communication to command the target Simulink® model and run the motor in a closed-loop control.

Required Hardware

This example supports these hardware configurations. Use the target model name (highlighted in
bold) to open the model for the corresponding hardware configuration, from the MATLAB® command
prompt.

• LAUNCHXL-F28069M controller + BOOSTXL-DRV8305 inverter:
mcb_pmsm_fwc_qep_f28069LaunchPad and mcb_pmsm_mtpa_qep_f28069LaunchPad

• LAUNCHXL-F28379D controller + BOOSTXL-DRV8305 inverter: mcb_pmsm_fwc_qep_f28379d
and mcb_pmsm_mtpa_qep_f28379d

For connections related to the preceding hardware configurations, see “LAUNCHXL-F28069M and
LAUNCHXL-F28379D configurations” on page 8-5.

Run Models to implement speed and torque control with field weakening & MTPA

1. Simulate the model and analyze the simulation results by using the preceding section.

2. Complete the hardware connections.

3. The torque control model requires an Interior PMSM with QEP Sensor, driven by an external
dynamometer with speed control (that uses the speed control model).

4. The model automatically computes the ADC (or current) offset values. To disable this functionality
(enabled by default), update the value zero to the variable inverter.ADCOffsetCalibEnable in the
model initialization script.

Alternatively, you can compute the ADC offset values and update it manually in the model
initialization scripts. For instructions to compute the ADC offset, see “Run 3-Phase AC Motors in
Open-loop Control and Calibrate ADC Offset” on page 4-52.

5. Compute the quadrature encoder index offset value and update it in the model initialization scripts
associated with the target model. For instructions to compute the quadrature encoder offset, see
“Quadrature Encoder Offset Calibration for PMSM Motor” on page 4-45.
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6. Open the target model for the hardware configuration that you want to use. If you want to change
the default hardware configuration settings for the target model, see “Model Configuration
Parameters” on page 2-2.

7. Load a sample program to CPU2 of LAUNCHXL-F28379D, for example, program that operates the
CPU2 blue LED by using GPIO31 (c28379D_cpu2_blink.slx), to ensure that CPU2 is not mistakenly
configured to use the board peripherals intended for CPU1.

8. Click Build, Deploy & Start in the Hardware tab to deploy the target model to the hardware.

9. Click the host model hyperlink in the target model to open the associated host model. You can
also use the "open_system" command to open the host model. For example, use this command for
speed control implementation:

open_system('mcb_pmsm_fwc_host_model.slx');
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For details about the serial communication between the host and target models, see “Communication
between Host and Target” on page 7-2.

10. In the Host Serial Setup block mask of the host model, select a Port name.

11. In the Speed control model, update the Reference Speed (RPM) block value. In the Torque control
model, update the current request using Imag Reference block.

12. Click Run in the Simulation tab to run the host model.

13. Change the Start / Stop Motor switch position to On, to start and stop running the motor.

14. Enter different reference speeds (or currents) and observe the debug signals from the RX
subsystem, in the Time Scope of host model.

Note

If the position offset is incorrect, this example can lead to excessive currents in the motor. To avoid
this, ensure that the position offset is correctly computed and updated in the workspace variable:
pmsm.PositionOffset.

When you operate the motor above the base speed, we recommended that you monitor the
temperature of motor. During motor operation, if the motor temperature rises beyond the
temperature recommended by the manufacturer, turn-off the motor for safety reasons.
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Hall Offset Calibration for PMSM Motor
This example calculates the offset between the rotor direct axis (d-axis) and position detected by Hall
sensor. The Field-Oriented Control (FOC) algorithm needs this position offset to run the PMSM
correctly. To compute the offset, the target model runs the motor in the open-loop condition. The
model uses a constant  (voltage along the stator's d-axis) and a zero  (voltage along the stator's q-
axis) to run the motor (at a low constant speed) by using a position or ramp generator. When the
position or ramp value reaches zero, the corresponding rotor position is the offset value for the Hall
sensors.

The control algorithm (available in the field-oriented control and parameter estimation examples)
uses this offset value to compute an accurate position of d-axis of the rotor. The controller needs this
offset to optimally run the Permanent Magnet Synchronous Motor (PMSM).

Models

The example includes these models:

• mcb_pmsm_hall_offset_f28069m

• mcb_pmsm_hall_offset_f28379d

You can use these models only for code generation. You can use the "open_system" command to open
the Simulink® model. For example, use this command for a F28069M based controller:

open_system('mcb_pmsm_hall_offset_f28069m.slx');

 Hall Offset Calibration for PMSM Motor

4-39



For the model names that you can use for different hardware configurations, see the Required
Hardware topic in the Generate Code and Deploy Model to Target Hardware section.

Required MathWorks® Products

To generate code and deploy model:

1. For the model: mcb_pmsm_hall_offset_f28069m

• Motor Control Blockset™
• Embedded Coder®
• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors

4 Implement Motor Speed Control by Using Field-Oriented Control (FOC)

4-40



• Fixed-Point Designer™

2. For the model: mcb_pmsm_hall_offset_f28379d

• Motor Control Blockset™
• Embedded Coder®
• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors
• Fixed-Point Designer™ (only needed for optimized code generation)

Prerequisites

• Update these motor parameters in the model initialization script associated with the target
models.

• Number of pole pairs
• Current control sample time (Ts)
• CPU frequency of the processor

For instructions to update the script, see “Estimate Control Gains from Motor Parameters” on page 3-
2.

Generate Code and Deploy Model to Target Hardware

This section instructs you to generate code and run the motor by using open-loop control.

The example uses a host and a target model. The host model is a user interface to the controller
hardware board. You can run the host model on the host computer. The prerequisite to use the host
model is to deploy the target model to the controller hardware board.

The host model uses serial communication to command the target model and run the motor in an
open-loop configuration. You can use the host model to control the motor rotations and validate
direction of rotation of the motor. The dashboard LED in the host model turns red to indicate that the
motor is running in reverse (anti-clockwise) direction. When the LED turns red, you must reverse the
motor phase connections to change the direction of rotation. The host model displays the calculated
offset value.

Required Hardware

This example supports these hardware configurations. Use the target model name (highlighted in
bold) to open the model for the corresponding hardware configuration, from the MATLAB® command
prompt.

• F28069M controller card + DRV8312-69M-KIT inverter: mcb_pmsm_hall_offset_f28069m

For connections related to the preceding hardware configuration, see “F28069 control card
configuration” on page 8-2.

• LAUNCHXL-F28379D controller + BOOSTXL-DRV8305 inverter:
mcb_pmsm_hall_offset_f28379d

For connections related to the preceding hardware configurations, see “LAUNCHXL-F28069M and
LAUNCHXL-F28379D configurations” on page 8-5.

Generate Code and Run Model on Target Hardware
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1. Complete the hardware connections.

2. Open the target model for the hardware configuration that you want to use. If you want to change
the default hardware configuration settings for the target model, see “Model Configuration
Parameters” on page 2-2.

3. Load a sample program to CPU2 of LAUNCHXL-F28379D, for example, program that operates the
CPU2 blue LED by using GPIO31 (c28379D_cpu2_blink.slx), to ensure that CPU2 is not mistakenly
configured to use the board peripherals intended for CPU1.

4. Click Build, Deploy & Start in the Hardware tab to deploy the target model to the hardware.

5. Click the host model hyperlink in the target model to open the associated host model. You can
also use the "open_system" command to open the host model. For example, use this command for a
F28069M based controller:

open_system('mcb_pmsm_host_offsetComputation_f28069m.slx');
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For details about the serial communication between the host and target models, see “Communication
between Host and Target” on page 7-2.

You can use the Time Scope in the host model to monitor the rotor position and offset values.

6. In the Host Serial Setup block mask of the host model, select a Port name.

7. Click Run in the Simulation tab to run the host model.

8. Change the Calibration Start / Stop switch position to On, to start running the motor.
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9. The dashboard LED turns green when the motor runs. Notice the rotor position and offset value
variation in the Time Scope (the position signal indicates a ramp signal with an amplitude between 0
and 1).

10. If the dashboard LED turns red, stop the motor by changing the Start / Stop Motor switch
position to Off. Turn off the DC power supply (24V) and reverse the motor phase connections from
ABC to CBA.

11. Repeat steps 4 to 8 and check if the dashboard LED is green. When the motor stops after
approximately 20 seconds, the host model displays the Hall sensor offset in the Offset box.

Note: This example does not support simulation.

For examples that implement FOC using a Hall sensor, update the computed offset in the
pmsm.PositionOffset parameter of the model initialization script linked to the example. For
instructions to update the script, see “Estimate Control Gains from Motor Parameters” on page 3-2.
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Quadrature Encoder Offset Calibration for PMSM Motor
This example calculates the offset between the d-axis of the rotor and encoder index pulse position
detected by the quadrature encoder sensor. The control algorithm (available in the field-oriented
control and parameter estimation examples) uses this offset value to compute an accurate and
precise position of the d-axis of rotor. The controller needs this position to implement the Field-
Oriented Control (FOC) correctly in the rotor flux reference frame (d-q reference frame), and
therefore, run the Permanent Magnet Synchronous Motor (PMSM) correctly.

Models

The example includes these models:

• mcb_pmsm_qep_offset_f28069m

• mcb_pmsm_qep_offset_f28069mLaunchPad

• mcb_pmsm_qep_offset_f28379d

You can use these models only for code generation. You can use the "open_system" command to open
the Simulink® model. For example, use this command for a F28069M based controller:

open_system('mcb_pmsm_qep_offset_f28069m.slx');
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For the model names that you can use for different hardware configurations, see the Required
Hardware topic in the Generate Code and Deploy Model to Target Hardware section.

Required MathWorks® Products

To generate code and deploy model:

1. For the models: mcb_pmsm_qep_offset_f28069m and
mcb_pmsm_qep_offset_f28069mLaunchPad

• Motor Control Blockset™
• Embedded Coder®
• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors
• Fixed-Point Designer™

2. For the model: mcb_pmsm_qep_offset_f28379d

• Motor Control Blockset™
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• Embedded Coder®
• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors
• Fixed-Point Designer™ (only needed for optimized code generation)

Prerequisites

• Update the motor parameters in the model initialization script associated with the target models.
For instructions to update the script, see “Estimate Control Gains from Motor Parameters” on
page 3-2

Update the following parameters in the model initialization script:

1. pmsm.QEPSlits

2. pmsm.QEPIndexOffset

3. Number of pole pairs

4. Current control sample time (Ts)

5. CPU frequency of processor

Generate Code and Deploy Model to Target Hardware

This section instructs you to generate code and run the motor by using open-loop control.

The example uses a host and a target model. The host model is a user interface to the controller
hardware board. You can run the host model on the host computer. The pre requisite to use the host
model is to deploy the target model to the controller hardware board.

The host model uses serial communication to command the target model and run the motor in an
open-loop configuration. You can use the host model to control the motor rotations and validate the
direction of rotation of motor. The dashboard LED in the host model turns red to indicate that the
motor is running in reverse direction. When the LED turns red, you must reverse the motor phase
connections (from ABC to CBA) to change the direction of rotation. After the target model receives
the motor-start command from the host model, the motor runs in open loop control for some time and
then stops. After the motor stops running, the target model aligns the rotor to the d-axis and captures
the position offset. The host model displays this offset value.

Required Hardware

This example supports these hardware configurations. Use the target model name (highlighted in
bold) to open the model for the corresponding hardware configuration, from the MATLAB® command
prompt.

• F28069M controller card + DRV8312-69M-KIT inverter: mcb_pmsm_qep_offset_f28069m

For connections related to the preceding hardware configuration, see “F28069 control card
configuration” on page 8-2.

• LAUNCHXL-F28069M controller + BOOSTXL-DRV8305 inverter:
mcb_pmsm_qep_offset_f28069mLaunchPad

• LAUNCHXL-F28379D controller + BOOSTXL-DRV8305 inverter:
mcb_pmsm_qep_offset_f28379d
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• LAUNCHXL-F28379D controller + BOOSTXL-3PHGANINV inverter:
mcb_pmsm_qep_offset_f28379d

NOTE: When using BOOSTXL-3PHGANINV inverter, ensure that proper insulation is available
between bottom layer of BOOSTXL-3PHGANINV and the LAUNCHXL board.

For connections related to the preceding hardware configurations, see “LAUNCHXL-F28069M and
LAUNCHXL-F28379D configurations” on page 8-5.

Generate Code and Run Model on Target Hardware

1. Complete the hardware connections.

2. Open the target model for the hardware configuration that you want to use. If you want to change
the default hardware configuration settings for the target model, see “Model Configuration
Parameters” on page 2-2.

3. Load a sample program to CPU2 of LAUNCHXL-F28379D, for example, program that operates the
CPU2 blue LED by using GPIO31 (c28379D_cpu2_blink.slx), to ensure that CPU2 is not mistakenly
configured to use the board peripherals intended for CPU1.

4. Click Build, Deploy & Start in the Hardware tab to deploy the target model to the hardware.

8. Click the host model hyperlink in the target model to open the associated host model. You can
also use the "open_system" command to open the host model. For example, use this command for a
F28069M based controller:

open_system('mcb_pmsm_host_offsetComputation_f28069m.slx');
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For details about the serial communication between the host and target models, see “Communication
between Host and Target” on page 7-2.

You can use the Time Scope in the host model to monitor the rotor position and offset values.

6. In the Host Serial Setup block mask of the host model, select a Port name.

7. Click Run in the Simulation tab to run the host model.

8. Change the Calibration Start / Stop switch position to On, to start running the motor.
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9. The dashboard LED turns green when the motor runs. Notice the rotor position and offset value
variations in the Time Scope (the position signal indicates a ramp signal with an amplitude between 0
and 1).

10. If the dashboard LED turns red, stop the motor by changing the Manual Switch position to Motor
Stop. Turn off the DC power supply (24V) and reverse the motor phase connections from ABC to CBA.

11. Repeat steps 7 and 8, and check if the dashboard LED is green.

12. After the motor runs for some time and stops, the host model displays the quadrature encoder
offset in the Offset block.

Note: This example does not support simulation.

For examples that implement FOC using a quadrature encoder sensor, you must update the computed
quadrature encoder offset value in the pmsm.PositionOffset parameter of the model initialization
script linked to the example. For instructions to update the script, see “Estimate Control Gains from
Motor Parameters” on page 3-2.
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Run 3-Phase AC Motors in Open-loop Control and Calibrate ADC
Offset

Open-loop control (also known as Scalar control or Volts/Hz control) is a motor control technique that
varies the stator voltage and frequency to control the rotor speed without using any feedback from
the motor. You can use this technique to check the integrity of the hardware connections. A constant
speed application of open-loop control uses a fixed frequency motor power supply. Whereas, an
adjustable speed application of open-loop control needs a variable frequency power supply to control
the rotor speed. To ensure a constant stator magnetic flux, we keep the supply voltage amplitude
proportional to its frequency.

Open-loop motor control does not have the ability to consider the external conditions that can affect
the motor speed. Therefore, the control system cannot automatically correct the deviation between
the desired and the actual motor speed.

This model runs the motor using an open-loop motor control algorithm. It helps you get started with
Motor Control Blockset™ and verify the hardware setup by running the motor. The target model
algorithm also reads the ADC values from the current sensors and sends it to the host model by using
serial communication.

Therefore, this model can be used to meet following objectives:

• Check connectivity with target.
• Check serial communication with target.
• Verify hardware and software environment.
• Check ADC Offsets for current sensors.
• Run a new motor with an inverter and target setup first time.

Models

The example includes these models:

• mcb_open_loop_control_f28069M_DRV8312

• mcb_open_loop_control_f28069MLaunchPad

• mcb_open_loop_control_f28379d

You can use these models for both simulation and code generation. You can use the "open_system"
command to open the Simulink® model. For example, use this command for a F28069M based
controller:

open_system('mcb_open_loop_control_f28069M_DRV8312.slx');
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For the model names that you can use for different hardware configurations, see the Required
Hardware topic in the Generate Code and Deploy Model to Target Hardware section.

Required MathWorks® Products

To simulate model:

1. For the models: mcb_open_loop_control_f28069M_DRV8312 and
mcb_open_loop_control_f28069MLaunchPad

• Motor Control Blockset™
• Fixed-Point Designer™

2. For the model: mcb_open_loop_control_f28379d
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• Motor Control Blockset™

To generate code and deploy model:

1. For the models: mcb_open_loop_control_f28069M_DRV8312 and
mcb_open_loop_control_f28069MLaunchPad

• Motor Control Blockset™
• Embedded Coder®
• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors
• Fixed-Point Designer™

2. For the model: mcb_open_loop_control_f28379d

• Motor Control Blockset™
• Embedded Coder®
• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors
• Fixed-Point Designer™ (only needed for optimized code generation)

Pre-requisites

1. Update the motor parameters in the model initialization script associated with the target models.
For instructions to update the script, see “Estimate Control Gains from Motor Parameters” on page 3-
2

2. For BOOSTXL-DRV8323, use these steps to update the model:

• Navigate to this path in the model: /Open Loop Control/Codegen/Hardware Initialization.

• For LAUNCHXL-F28379D: Update DRV830x Enable block from GPIO124 to GPIO67.

• For LAUNCHXL-F28069M: Update DRV830x Enable block from GPIO50 to GPIO12.

3. For BOOSTXL-3PHGANINV, use these steps to update the model:

• Navigate to this path in the model: /Open Loop Control/Codegen/Hardware Initialization.

• Add a NOT logical operator block between Enable and DRV830x Enable.

NOTE: When using BOOSTXL-3PHGANINV inverter, ensure that proper insulation is available
between bottom layer of BOOSTXL-3PHGANINV and the LAUNCHXL board.

Simulate Model

This example supports simulation. Follow these steps to simulate the model.

1. Open a model included with this example.

2. Click Run in the Simulation tab to simulate the model.

3. Click Data Inspector in the Simulation tab to view and analyze the simulation results.

Generate Code and Deploy Model to Target Hardware

This section instructs you to generate code and run the motor by using open-loop control.
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The example uses a host and a target model. The host model is a user interface to the controller
hardware board. You can run the host model on the host computer. The pre requisite to use the host
model is to deploy the target model to the controller hardware board. The host model uses serial
communication to command the target Simulink® model and run the motor in a closed-loop control.

Required Hardware

This example supports these hardware configurations. Use the target model name (highlighted in
bold) to open the model for the corresponding hardware configuration, from the MATLAB® command
prompt.

• F28069M controller card + DRV8312-69M-KIT inverter:
mcb_open_loop_control_f28069M_DRV8312

For connections related to the preceding hardware configuration, see “F28069 control card
configuration” on page 8-2.

• LAUNCHXL-F28069M controller + (BOOSTXL-DRV8301 or BOOSTXL-DRV8305 or BOOSTXL-
DRV8323 or BOOSTXL-3PHGANINV) inverter: mcb_open_loop_control_f28069MLaunchPad

• LAUNCHXL-F28379D controller + (BOOSTXL-DRV8301 or BOOSTXL-DRV8305 or BOOSTXL-
DRV8323 or BOOSTXL-3PHGANINV) inverter: mcb_open_loop_control_f28379d

For connections related to the preceding hardware configurations, see “LAUNCHXL-F28069M and
LAUNCHXL-F28379D configurations” on page 8-5.

NOTE:

• This example supports any type of three-phase AC motor (PMSM or induction) and any type of
inverter attached to the supported hardware.

• Some PMSMs do not run at higher speeds, especially when the shaft is loaded. To resolve this
issue, you should apply more voltages corresponding to a given frequency. You can use these steps
to increase the applied voltages in the model:

1. Navigate to this path in the model: /Open Loop Control/Control_System/VabcCalc/.

2. Update the gain "Correction_Factor_sinePWM" as 20%.

3. For safety reasons, regularly monitor the motor shaft, motor current, and motor temperature.

Generate Code and Run Model to Implement Open-loop Control

1. Simulate the target model and observe the simulation results.

2. Complete the hardware connections.

3. Open the target model for the hardware configuration that you want to use. If you want to change
the default hardware configuration settings for the target model, see “Model Configuration
Parameters” on page 2-2.

4. Load a sample program to CPU2 of LAUNCHXL-F28379D, for example, program that operates the
CPU2 blue LED by using GPIO31 (c28379D_cpu2_blink.slx), to ensure that CPU2 is not mistakenly
configured to use the board peripherals intended for CPU1.

5. Click Build, Deploy & Start in the Hardware tab to deploy the target model to the hardware.
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NOTE: Ignore the warning message "Multitask data store option in the Diagnostics page of the
Configuration Parameter Dialog is none" displayed by the model advisor, by clicking the Always
Ignore button. This is part of the intended workflow.

6. Click the host model hyperlink in the target model to open the associated host model. You can
also use the "open_system" command to open the host model. For example, use this command for a
F28069M based controller:

open_system('mcb_open_loop_control_host_model.slx');
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For details about the serial communication between the host and target models, see “Communication
between Host and Target” on page 7-2.

7. In the Host Serial Setup block mask of the host model, select a Port name.

8. Click Run in the Simulation tab to run the host model.

9. Change the Start / Stop Motor switch position to On, to start running the motor.

10. After the motor runs, observe the ADC counts for the  and  currents in the Time Scope.

If the motor does not run, change the Start / Stop Motor switch position to Off, to stop the motor and
change the Reference Speed in the host model. Afterwards, change the Start / Stop Motor switch
position to On, to run the motor again.

Generate Code and Run Model to Calibrate ADC Offset

1. Simulate the target model and observe the simulation results.

2. Complete the hardware connections.

3. Disconnect the motor wires for three phases, from the hardware board terminals.

4. Open the target model for the hardware configuration that you want to use. If you want to change
the default hardware configuration settings for the target model, see “Model Configuration
Parameters” on page 2-2.

5. Load a sample program to CPU2 of LAUNCHXL-F28379D (for example, program that operates the
CPU2 blue LED using GPIO31) to ensure that CPU2 is not mistakenly configured to use the board
peripherals intended for CPU1.

6. Click Build, Deploy & Start in the Hardware tab to deploy the target model to the hardware.

NOTE: Ignore the warning message "Multitask data store option in the Diagnostics page of the
Configuration Parameter Dialog is none" displayed by the model advisor, by clicking the Always
Ignore button. This is part of the intended workflow.

7. Click the host model hyperlink in the target model to open the associated host model.

8. In the Host Serial Setup block mask of the host model, select a Port name.

9. Click Run in the Simulation tab to run the host model.

10. Observe the ADC counts for the  and  currents in the Time Scope. The average values of the
ADC counts are the ADC offset corrections for the currents  and . You can use these steps to
obtain the average (median) values of ADC counts: * In the Scope window, navigate to Tools >
Measurements, and select the Signal Statistics option to display the Trace Selection and Signal
Statistics areas.
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• In the Trace Selection area select a signal (  or ). The window display the characteristics of
the selected signal in the Signal Statistics area. You can see the median value of the selected
signal in the Median field.
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For the Motor Control Blockset examples, update the computed ADC (or current) offset value in the
inverter.CtSensAOffset and inverter.CtSensBOffset variables in the model initialization script linked
to the example. For instructions to update the script, see “Estimate Control Gains from Motor
Parameters” on page 3-2.
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Control Parameter Gain Tuning (Manual) in Hardware and Plant
Validation

This example uses Field-Oriented Control technique to run the motor in the following modes of
operation:

• Stop - In this mode, the motor stops running because the inverter outputs zero volts.

• Open loop - In this mode, the controller uses open-loop control to run the motor. You can use the
Operating Mode Variables area of the host model to change the output voltage of the inverter
and the rotor speed. Use the Monitor area to select the speed and rotor position values to display
them on the scope for monitoring.

• Torque control mode - In this mode, the controller uses a torque control algorithm to run the
motor. You can use the Operating Mode Variables area of the host model to change the 
reference and  reference currents.

You can also lock the rotor by turning the slider switch to Pos lock position that sets the rotor position
to zero. Therefore, in this mode the controller receives the position feedback as zero because the
motor stops running. If you turn the switch to Unlock position, the motor runs and the controller
receives position feedback from the quadrature encoder (you can monitor this value by using the
Position_meas signal in the Monitor area of host model). You can use the scope to monitor the two
debug signals (Monitor Signal #1 and Monitor Signal #2) that you select in the Monitor area.
Therefore, you can use the slider switch to tune the torque control gain parameters.

• Speed control mode - In this mode, the controller uses a speed control algorithm to run the motor.
You can use the Operating Mode Variables area of the host model to change the Speed
Reference value (in per-unit) of the rotor. You can use the scope to monitor the two debug signals
(Monitor Signal #1 and Monitor Signal #2) that you select in the Monitor area. For information
related to the per-unit system, see “Per-Unit System” on page 7-15.

You can use the Control loop gains area of the host model to change the control parameters of the
d-axis and q-axis current controllers and the speed controller.

This example implements the Field-Oriented Control (FOC) technique to control a three-phase
Permanent Magnet Synchronous Motor (PMSM). You need a real time feedback of the rotor position
to implement an FOC algorithm. This example uses a quadrature encoder sensor to measure the rotor
position. For details about implementing FOC, see “Implement Motor Speed Control Using Field-
Oriented Control (FOC)” on page 4-2.

You can use this example to run the motor in open-loop control, torque control, and speed control
modes. You can also use this example for tuning the hardware gains and validating the plant model.

Note: We recommend that you stop the motor first before transitioning from one operating mode to
the other.

You can select one of the following operating modes in the Control area of the host model:

• Stop
• Open loop run
• Torque control
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• Speed control

Model

The example includes this model:

• mcb_pmsm_operating_mode_f28379d

You can use the model for both simulation and code generation. You can use the "open_system"
command to open the Simulink® model:

open_system('mcb_pmsm_operating_mode_f28379d.slx');

Required MathWorks® Products

To simulate model:

• Motor Control Blockset™

To generate code and deploy model:

1. Motor Control Blockset™

2. Embedded Coder®

3. Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors

4. Fixed-Point Designer™

Prerequisites

1. Obtain the motor parameters. We provide default motor parameters with the Simulink® model that
you can replace with the values from either the motor datasheet or other sources.

However, if you have the motor control hardware, you can estimate the parameters for the motor that
you want to use, by using the Motor Control Blockset parameter estimation tool. For instructions , see
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“Estimate Motor Parameters by Using Motor Control Blockset Parameter Estimation Tool” on page 6-
2.

The parameter estimation tool updates the motorParam variable (in the MATLAB® workspace) with
the estimated motor parameters.

2. If you obtain the motor parameters from the datasheet or other sources, update the motor
parameters and inverter parameters in the model initialization script associated with the Simulink®
models. For instructions to update the script, see “Estimate Control Gains from Motor Parameters” on
page 3-2

If you use the parameter estimation tool, you can update the inverter parameters, but do not update
the motor parameters in the model initialization script. The script automatically extracts motor
parameters from the updated motorParam workspace variable.

Simulate Model

This example supports simulation only for the Speed Control operating mode. Follow these steps to
simulate the model.

1. Open the model included with this example.

2. Click Run in the Simulation tab to simulate the model.

3. Click Data Inspector in the Simulation tab to view and analyze the simulation results.

Generate Code and Deploy Model to Target Hardware

This section instructs you to generate code and run the FOC algorithm on the target hardware.

The example uses a host and a target model. The host model is a user interface to the controller
hardware board. You can run the host model on the host computer. The pre requisite to use the host
model is to deploy the target model to the controller hardware board. The host model uses serial
communication to command the model, run (and control) the motor in a selected operating mode, and
monitor the debug signals of the model.

Required Hardware

This example supports these hardware configurations. Use the target model name (highlighted in
bold) to open the model for the corresponding hardware configuration, from the MATLAB® command
prompt.

• LAUNCHXL-F28379D controller + BOOSTXL-DRV8305 inverter:
mcb_pmsm_operating_mode_f28379d

For connections related to the preceding hardware configurations, see “LAUNCHXL-F28069M and
LAUNCHXL-F28379D configurations” on page 8-5.

Generate Code and Run Model on Target Hardware

1. Simulate the target model and observe the simulation results.

2. Complete the hardware connections.
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3. The model automatically computes the ADC (or current) offset values. To disable this functionality
(enabled by default), update the value 0 to the variable inverter.ADCOffsetCalibEnable in the model
initialization script.

Alternatively, you can compute the ADC offset values and update it manually in the model
initialization scripts. For instructions to compute the ADC offset, see “Run 3-Phase AC Motors in
Open-loop Control and Calibrate ADC Offset” on page 4-52.

4. Compute the quadrature encoder index offset value and update it in the model initialization scripts
associated with the target model. For instructions to compute the quadrature encoder offset, see
“Quadrature Encoder Offset Calibration for PMSM Motor” on page 4-45.

5. Open the target model for the hardware configuration that you want to use. If you want to change
the default hardware configuration settings for the model, see “Model Configuration Parameters” on
page 2-2.

6. Load a sample program to CPU2 of LAUNCHXL-F28379D, for example, program that operates the
CPU2 blue LED by using GPIO31 (c28379D_cpu2_blink.slx), to ensure that CPU2 is not mistakenly
configured to use the board peripherals intended for CPU1.

NOTE:

• Do not directly switch between the open-loop, torque control, and speed control operating modes.
Always stop the motor before changing the operating mode.

• Before you run the motor in speed control mode for the first time, run the motor in open-loop to
determine the quadratue encoder index. This helps to start the motor smoothly in the closed-loop
speed control mode.

Instructions for Open loop run operating mode:

1. Click Build, Deploy & Start in the Hardware tab to deploy the target model to the hardware.

2. Click the host model hyperlink in the target model to open the associated host model.

3. In the Host Serial Setup block mask of the host model, select a Port name.

4. Click Run in the Simulation tab to run the host model.

5. Select Stop in the Control area to stop the motor.

6. Select Open loop run to start the motor.

Instructions for Torque control operating mode:

1. Click Build, Deploy & Start in the Hardware tab to deploy the target model to the hardware.

2. Click the host model hyperlink in the target model to open the associated host model.

3. In the Host Serial Setup block mask of the host model, select a Port name.

4. Click Run in the Simulation tab to run the host model.

5. Select Stop in the Control area to stop the motor.
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6. Enter the value 0 (per-unit) in the Id Reference and Iq Reference fields in the Operating Mode
Variables area.

7. Select Torque control in the Control area.

8. Move the slider switch to Unlock position in the Operating Mode Variables area.

9. Select Iq_ref for Monitor Signal #1 and Iq_meas for Monitor Signal #2 in the Monitor area.

10. Enter the value 0.1 (per-unit) in the in the Iq Reference field (in the Operating Mode Variables
area) to start running the motor.

11. Open the scope in the host model and monitor the Iq_ref and Iq_meas current signals.

Note: The motor can reach high speeds if you run it under no load condition in this operating mode.
In addition, the motor will not meet the Iq reference current under no load condition in this operating
mode.

Instructions for the Speed control operating mode:

1. Click Build, Deploy & Start in the Hardware tab to deploy the target model to the hardware.

2. Click the host model hyperlink in the target model to open the associated host model.

3. In the Host Serial Setup block mask of the host model, select a Port name.

4. Click Run in the Simulation tab to run the host model.

5. Select Stop in the Control area to stop the motor.

6. Enter the value 0.5 (per-unit) in the Speed Reference field in the Operating Mode Variables
area.

7. Select Speed control in the Control area.

8. Select Speed_ref for Monitor Signal #1 and Speed_meas for Monitor Signal #2 in the
Monitor area.

9. Open the scope in the host model and monitor the Speed_ref and Speed_meas output signals.

Instructions for tuning the gain of torque controller:

1. Click Build, Deploy & Start in the Hardware tab to deploy the target model to the hardware.

2. Click the host model hyperlink in the target model to open the associated host model.

3. In the Host Serial Setup block mask of the host model, select a Port name.

4. Click Run in the Simulation tab to run the host model.

5. Select Stop in the Control area to stop the motor.

6. Select Torque control in the Control area.

7. Turn the slider switch to Pos lock position in the Operating Mode Variables area.

8. Select Id_ref for Monitor Signal #1 and Id_meas for Monitor Signal #2 in the Monitor area.
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9. Enter the value 0.2 (per-unit) in the Id Reference field in the Operating Mode Variables area.

10. Open the scope and monitor the step response signal.

11. Tune the control gains Kp and Ki for the d-axis current controller.

Instructions for tuning the gain of speed controller:

1. Click Build, Deploy & Start in the Hardware tab to deploy the target model to the hardware.

2. Click the host model hyperlink in the target model to open the associated host model.

3. In the Host Serial Setup block mask of the host model, select a Port name.

4. Click Run in the Simulation tab to run the host model.

5. Select Stop in the Control area to stop the motor.

6. Select Speed control in the Operating Mode Variables area.

7. Select Speed_ref for Monitor Signal #1 and Speed_meas for Monitor Signal #2 in the
Monitor area.

8. Enter the value 0.5 (per-unit) in the Speed Reference field in the Operating Mode Variables
area.

9. Open the scope and observe the reference and the measured speed values.

10. Enter the value 0.8 (per-unit) in the Speed Reference field.

11. Observe the speed step response in the scope.

12. Tune the control gains Kp and Ki for the speed controller.

Instructions for validating the plant model:

1. Click the host model hyperlink in the target model to open the associated host model.

2. In the Host Serial Setup block mask of the host model, select a Port name.

3. Click Run in the Simulation tab to run the host model.

4. Open the target model using the following command:
open_system('mcb_pmsm_operating_mode_f28379d.slx');

5. Change Manual Switch (in mcb_pmsm_operating_mode_f28379d.slx/Speed Control/Speed_control)
position to Simulate Step Speed Input.

6. Simulate the model mcb_pmsm_operating_mode_f28379d.slx.

7. Open the scope in the model to observe the step response of the speed controller.

8. Click Build, Deploy & Start in the Hardware tab to deploy the target model to the hardware.

9. Select Stop in the Control area of the host model to ensure that the motor is not running.

10. Select Speed control in the Operating Mode Variables area.
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11. Select Speed_ref for Monitor Signal #1 and Speed_meas for Monitor Signal #2 in the
Monitor area.

12. Enter the value 0.2 (per-unit) in the Speed Reference field in the Operating Mode Variables
area.

13. Open the scope and observe the reference and the measured speed values.

14. Enter the value 0.5 (per-unit) in the Speed Reference field.

15. Observe the speed step response in the scope.

16. Compare the speed step responses obtained in steps 6 (with simulation) and 15 (with code
generation).

Note: You can also use the "open_system" command to open the host model:

open_system('mcb_host_mode_control.slx');
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In the Control loop gains area, you must enter the gain values that can be represented by the
datatype defined in the model initialization script.

For details about the serial communication between the host and target models, see “Communication
between Host and Target” on page 7-2.
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Monitoring Resolver Using Serial Communication
This example operates the resolver sensor to measure the rotor position. The resolver consists of two
orthogonally placed stator windings placed around the resolver rotor winding. After you mount the
resolver sensor over a PMSM, the resolver rotor winding rotates along with the shaft of the running
motor. The controller provides a fixed frequency alternating excitation signal to the resolver rotor
winding. When the resolver rotor rotates, the resolver stator windings produce output (secondary
sine and cosine) signals that are modulated with the sine and cosine of the shaft angle or position.
After receiving the secondary signals, the controller samples and normalizes them.
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Models

The example includes this model:

• mcb_resolver_f28069m

You can use this models only for code generation. You can use the "open_system" command to open
the Simulink® model. For example, use this command for a F28069M based controller:

open_system('mcb_resolver_f28069m.slx');
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Required MathWorks® Products

For the model: mcb_resolver_f28069m

• Motor Control Blockset™
• Embedded Coder®
• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors
• Fixed-Point Designer™

Prerequisite

We provide default inverter parameters with the target model. If you want to change the default
values, you can update the inverter parameters in the model initialization script associated with the
Simulink® model. For instructions to update the script, see “Estimate Control Gains from Motor
Parameters” on page 3-2

Generate Code and Deploy Model to Target Hardware

This section instructs you to generate code and run the FOC algorithm on the target hardware.

The example uses a host and a target model. The host model is a user interface to the controller
hardware board. You can run the host model on the host computer. The pre requisite to use the host
model is to deploy the target model to the controller hardware board. The controller in the target
model uses the Resolver Decoder block to process the sampled and normalized secondary sine and
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cosine signals to obtain the shaft (or motor) position. The host model uses serial communication to
command the target model and obtain the computed shaft angle from the controller. You can observe
the computed shaft position in the Time Scope block of the host model.

Required Hardware

This example supports this hardware configuration. Use the target model name (highlighted in bold)
to open the model for the corresponding hardware configuration, from the MATLAB® command
prompt.

• LAUNCHXL-F28069M controller + BOOSTXL-DRV8305 inverter: mcb_resolver_f28069m

For connections related to the preceding hardware configuration, see “LAUNCHXL-F28069M and
LAUNCHXL-F28379D configurations” on page 8-5.

Generate Code and Run Model on Target Hardware

1. Complete the hardware connections and open the target model mcb_resolver_f28069m.

2. Load a sample program to CPU2 of LAUNCHXL-F28379D, for example, program that operates the
CPU2 blue LED by using GPIO31 (c28379D_cpu2_blink.slx), to ensure that CPU2 is not mistakenly
configured to use the board peripherals intended for CPU1.

3. Click Build, Deploy & Start in the Hardware tab to deploy the target model to the hardware.

4. Click the host model hyperlink in the target model to open the associated host model. You can
also use the "open_system" command to open the host model. For example, use this command for the
F28069M based controller:

open_system('mcb_resolver_host_read.slx');
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For details about the serial communication between the host and target models, see “Communication
between Host and Target” on page 7-2.

5. In the Serial Receive and Serial Configuration block masks of the host model, select a
Communication port value.

6. If you want to change the default baud rate (in the host and target models), use the Serial
Configuration block mask in the models to select a different Baud rate value.

7. Click Run in the Simulation tab to run the host model.

8. Open the Time Scope block in the host model.

9. Rotate the resolver shaft and observe the computed shaft position signal in the Time Scope block.
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Field Oriented Control of PMSM by Using SI Units
This example implements the Field-Oriented Control (FOC) technique to control the speed of a three-
phase Permanent Magnet Synchronous Motor (PMSM). However, instead of the per-unit
representation of quantities(for details about the per-unit system, see “Per-Unit System” on page 7-
15), the FOC algorithm in this example uses the SI units of signals to perform the computations.
Following are the signals and their SI units:

• Rotor speed - Radians/ sec

• Rotor position - Radians

• Currents - Amperes

• Voltages - Volts

Field-oriented control (FOC) needs a real time feedback of the rotor position. This example uses the
quadrature encoder sensor to measure the rotor position. For details about implementing FOC, see
“Implement Motor Speed Control Using Field-Oriented Control (FOC)” on page 4-2.

Models

The example includes this model:

• mcb_pmsm_foc_qep_f28379d_SIUnit

You can use this model for both simulation and code generation. You can use the "open_system"
command to open the Simulink® model. For example, use this command for a F28379D based
controller:

open_system('mcb_pmsm_foc_qep_f28379d_SIUnit.slx');

Required MathWorks® Products

To simulate model:
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• Motor Control Blockset™

To generate code and deploy model:

• Motor Control Blockset™
• Embedded Coder®
• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors
• Fixed-Point Designer™ (only needed for optimized code generation)

Prerequisites

1. Obtain the motor parameters. We provide default motor parameters with the Simulink® model that
you can replace with the values from either the motor datasheet or other sources.

However, if you have the motor control hardware, you can estimate the parameters for the motor that
you want to use, by using the Motor Control Blockset parameter estimation tool. For instructions , see
“Estimate Motor Parameters by Using Motor Control Blockset Parameter Estimation Tool” on page 6-
2.

The parameter estimation tool updates the motorParam variable (in the MATLAB® workspace) with
the estimated motor parameters.

2. If you obtain the motor parameters from the datasheet or other sources, update the motor
parameters and inverter parameters in the model initialization script associated with the Simulink®
models. For instructions to update the script, see “Estimate Control Gains from Motor Parameters” on
page 3-2

If you use the parameter estimation tool, you can update the inverter parameters, but do not update
the motor parameters in the model initialization script. The script automatically extracts motor
parameters from the updated motorParam workspace variable.

Simulate Model

This example supports simulation. Follow these steps to simulate the model.

1. Open the model included with this example.

2. Click Run in the Simulation tab to simulate the model.

3. Click Data Inspector in the Simulation tab to view and analyze the simulation results.

Generate Code and Deploy Model to Target Hardware

This section instructs you to generate code and run the FOC algorithm on the target hardware.

The example uses a host and a target model. The host model is a user interface to the controller
hardware board. You can run the host model on the host computer. The pre requisite to use the host
model is to deploy the target model to the controller hardware board. The host model uses serial
communication to command the target model and run the motor in a closed-loop control.

Required Hardware

This example supports this hardware configuration. Use the target model name (highlighted in bold)
to open the model for the corresponding hardware configuration, from the MATLAB® command
prompt.
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• LAUNCHXL-F28379D controller + BOOSTXL-DRV8305 inverter:
mcb_pmsm_foc_qep_f28379d_SIUnit

For connections related to the preceding hardware configurations, see “LAUNCHXL-F28069M and
LAUNCHXL-F28379D configurations” on page 8-5.

Generate Code and Run Model on Target Hardware

1. Simulate the target model and observe the simulation results.

2. Complete the hardware connections.

3. The model automatically computes the ADC (or current) offset values. To disable this functionality
(enabled by default), update the value 0 to the variable inverter.ADCOffsetCalibEnable in the model
initialization script.

Alternatively, you can compute the ADC offset values and update it manually in the model
initialization scripts. For instructions to compute the ADC offset, see “Run 3-Phase AC Motors in
Open-loop Control and Calibrate ADC Offset” on page 4-52.

4. Compute the quadrature encoder index offset value and update it in the model initialization scripts
associated with the target model. For instructions to compute the quadrature encoder offset, see
“Quadrature Encoder Offset Calibration for PMSM Motor” on page 4-45.

5. Open the target model. If you want to change the default hardware configuration settings for the
model, see “Model Configuration Parameters” on page 2-2.

6. Load a sample program to CPU2 of LAUNCHXL-F28379D, for example, program that operates the
CPU2 blue LED by using GPIO31 (c28379D_cpu2_blink.slx), to ensure that CPU2 is not mistakenly
configured to use the board peripherals intended for CPU1.

7. Click Build, Deploy & Start in the Hardware tab to deploy the target model to the hardware.

8. Click the host model hyperlink in the target model to open the associated host model. You can
also use the "open_system" command to open the host model. For example, use this command for a
F28069M based controller:

open_system('mcb_pmsm_SIUnit_host_model.slx');
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For details about the serial communication between the host and target models, see “Communication
between Host and Target” on page 7-2.

9. In the Host Serial Setup block mask of the host model, select a Port name.

10. Update the Reference Speed value in the host model.

11. Click Run in the Simulation tab to run the host model.

12. Change the Start / Stop Motor switch position to On, to start running the motor.

13. Observe the debug signals from the RX subsystem, in the Time Scope of host model.
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Modeling Switching Dynamics in the Inverter by using
Simscape Electrical

This example implements the Field-Oriented Control (FOC) technique to control the speed of a three-
phase Permanent Magnet Synchronous Motor (PMSM). However, in addition to the Average Value
Inverter block, the example provides you the option to use the following blocks as an alternative to
the Average Value Inverter block:

• Simscape™ Electrical™ 3 phase converter
• Simscape Electrical MMC (Modular Multilevel Converter)

The example also provides you the option to use the PMSM Simscape Electrical block as an
alternative to the Surface Mount PMSM Motor Control Blockset™ block.

Field-oriented control (FOC) needs a real time feedback of the rotor position. This example uses the
quadrature encoder sensor to measure the rotor position. For details about implementing FOC, see
“Implement Motor Speed Control Using Field-Oriented Control (FOC)” on page 4-2.

You can use this example to simulate the target model by using different inverters and monitor the
feedback current for each inverter. You can also generate the code and use the host along with the
target model.

Models

The example includes this model:

• mcb_ee_pmsm_foc

You can use this model for both simulation and code generation. You can use the "open_system"
command to open the Simulink® model. For example, use this command for a F28379D based
controller:

open_system('mcb_ee_pmsm_foc.slx');
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Required MathWorks® Products

To simulate model:

• Motor Control Blockset™

To generate code and deploy model:

• Motor Control Blockset™
• Embedded Coder®
• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors
• Fixed-Point Designer™ (only needed for optimized code generation)

Prerequisites

1. Obtain the motor parameters. We provide default motor parameters with the Simulink® model that
you can replace with the values from either the motor datasheet or other sources.

However, if you have the motor control hardware, you can estimate the parameters for the motor that
you want to use, by using the Motor Control Blockset parameter estimation tool. For instructions , see
“Estimate Motor Parameters by Using Motor Control Blockset Parameter Estimation Tool” on page 6-
2.

The parameter estimation tool updates the motorParam variable (in the MATLAB® workspace) with
the estimated motor parameters.

2. If you obtain the motor parameters from the datasheet or other sources, update the motor
parameters and inverter parameters in the model initialization script associated with the Simulink®
models. For instructions to update the script, see “Estimate Control Gains from Motor Parameters” on
page 3-2

If you use the parameter estimation tool, you can update the inverter parameters, but do not update
the motor parameters in the model initialization script. The script automatically extracts motor
parameters from the updated motorParam workspace variable.

Simulate Model

This example supports simulation. Follow these steps to simulate the model.

1. Open the target model mcb_ee_pmsm_foc.

2. You can select one of the following options in the InverterSelected radio group in the target model
(to select the inverter and motor blocks that you want to use):

• MCB average inverter - Select this option to use the Average Inverter and Surface Mount PMSM
Motor Control Blockset blocks.

• Sim Electrical 3 phase converter - Select this option to use the 3 phase converter and PMSM
Simscape Electrical blocks.

• Sim Electrical Modular Multilevel converter - Select this option to use the MMC and PMSM
Simscape Electrical blocks.

3. Select MCB average inverter in the InverterSelected radio group and click Run in the Simulation
tab to simulate the target model.
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4. Select Sim Electrical 3 phase converter in the InverterSelected radio group and click Run to
simulate the target model.

5. Select Sim Electrical Modular Multilevel converter in the InverterSelected radio group and click
Run to simulate the target model.

6. On the target model, click Data Inspector in the Simulation tab to view results from the three
simulation runs.

This image shows the simulation results for  phase current:

These images show the comparison of rotor speed,  current,  phase current, and rotor position
for the three inverter types:
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These images show the comparison of PWM modulation waveforms for the three inverter types:
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Generate Code and Deploy Model to Target Hardware

This section instructs you to generate code and run the FOC algorithm on the target hardware.

The example uses a host and a target model. The host model is a user interface to the controller
hardware board. You can run the host model on the host computer. The pre requisite to use the host
model is to deploy the target model to the controller hardware board. The host model uses serial
communication to command the target Simulink® model and run the motor in a closed-loop control.

Required Hardware

This example supports this hardware configuration. Use the target model name (highlighted in bold)
to open the model for the corresponding hardware configuration, from the MATLAB® command
prompt.
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• LAUNCHXL-F28379D controller + BOOSTXL-DRV8305 inverter: mcb_ee_pmsm_foc

For connections related to the preceding hardware configurations, see “LAUNCHXL-F28069M and
LAUNCHXL-F28379D configurations” on page 8-5.

Generate Code and Run Model on Target Hardware

1. Simulate the target model and observe the simulation results.

2. Complete the hardware connections.

3. The model automatically computes the ADC (or current) offset values. To disable this functionality
(enabled by default), update the value 0 to the variable inverter.ADCOffsetCalibEnable in the model
initialization script.

Alternatively, you can compute the ADC offset values and update it manually in the model
initialization scripts. For instructions to compute the ADC offset, see “Run 3-Phase AC Motors in
Open-loop Control and Calibrate ADC Offset” on page 4-52.

4. Compute the quadrature encoder index offset value and update it in the model initialization scripts
associated with the target model. For instructions to compute the quadrature encoder offset, see
“Quadrature Encoder Offset Calibration for PMSM Motor” on page 4-45.

5. Open the target model. If you want to change the default hardware configuration settings for the
model, see “Model Configuration Parameters” on page 2-2.

4. Load a sample program to CPU2 of LAUNCHXL-F28379D, for example, program that operates the
CPU2 blue LED by using GPIO31 (c28379D_cpu2_blink.slx), to ensure that CPU2 is not mistakenly
configured to use the board peripherals intended for CPU1.

5. Click Build, Deploy & Start in the Hardware tab to deploy the target model to the hardware.

8. Click the host model hyperlink in the target model to open the associated host model. You can
also use the "open_system" command to open the host model. For example, use this command for a
F28069M based controller:

open_system('mcb_pmsm_foc_host_model_f28379d.slx');
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For details about the serial communication between the host and target models, see “Communication
between Host and Target” on page 7-2.

7. In the Host Serial Setup block mask of the host model, select a Port name.

8. Update the Reference Speed value in the host model.

9. Click Run in the Simulation tab to run the host model.

10. Change the Start / Stop Motor switch position to On, to start running the motor.

11. Observe the debug signals from the RX subsystem, in the Time Scope and Display blocks of the
host model.

Note: In the host model, you can also select the debug signals that you want to monitor.
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Tune PI controllers by Using Field Oriented Control (FOC)
Autotuner

This example computes the gain values of the PI controllers within the speed and current controllers
by using the Field Oriented Control Autotuner block. For details about implementing FOC, see
“Implement Motor Speed Control Using Field-Oriented Control (FOC)” on page 4-2.

The example supports only simulation. When you simulate the example, the model uses the crude
values of gains for the PI controllers to achieve the steady state of speed-control operation.

The model begins tuning only in the steady state. It introduces disturbances depending on the
controller goals (bandwidth and phase margin), in the controller output. The model uses the system
response to the disturbances, to calculate the optimal controller gain.

Model

The example includes this model:

• mcb_pmsm_foc_autotuner

You can use this model only for simulation. You can use the "open_system" command to open the
Simulink® model:

open_system('mcb_pmsm_foc_autotuner.slx');

Required MathWorks® Products for Simulation

• Motor Control Blockset™
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• Fixed-Point Designer™

Prerequisites

1. Obtain the motor parameters. We provide default motor parameters with the Simulink® model that
you can replace with the values from either the motor datasheet or other sources.

However, if you have the motor control hardware, you can estimate the parameters for the motor that
you want to use, by using the Motor Control Blockset parameter estimation tool. For instructions , see
“Estimate Motor Parameters by Using Motor Control Blockset Parameter Estimation Tool” on page 6-
2.

The parameter estimation tool updates the motorParam variable (in the MATLAB® workspace) with
the estimated motor parameters.

2. If you obtain the motor parameters from the datasheet or other sources, update the motor
parameters and inverter parameters in the model initialization script associated with the Simulink®
models. For instructions to update the script, see “Estimate Control Gains from Motor Parameters” on
page 3-2

If you use the parameter estimation tool, you can update the inverter parameters, but do not update
the motor parameters in the model initialization script. The script automatically extracts motor
parameters from the updated motorParam workspace variable.

Note: In addition to the preceding products, you also need these products to use the parameter
estimation tool:

• Embedded Coder®

• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors

Simulate and Run Model to Compute PI Controller Gains

1. Open the target model.

2. Click Run in the Simulation tab to simulate the target model.

3. Observe the computed PI controller gain values in the Display blocks available in the
PI_Params_Display_and_Logging subsystem.

4. Update any target model with these gain values so that it brings the motor to a steady-speed state
quickly.
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Use Motor Control Blockset™ to Generate Code for a Custom
Target

This example shows how to use the Motor Control Blockset™ product with any processor. The
algorithm part of the model is separated from the driver layer by using a model reference that you
can deploy on any device.

Field Oriented Control (FOC) of PMSM

This example enables you to simulate and generate code from a system model that is configured for
TI C2000 F28069M processor. This system model refers to a model reference for the Field-Oriented
Control (FOC) implementation which you could run on any processor.

Required Products

• MATLAB®
• Simulink®
• Matlab® Coder™
• Simulink® Coder™
• Motor Control Blockset™
• EmbeddedCoder®
• Fixed-Point Designer™ (only for serial communication)

Verify Algorithm Behavior by Using System Simulation

This section instructs you to verify the controller in a closed loop system simulation.

The system model "mcb_pmsm_foc_system" test bench consists of the test inputs, embedded
processor, power electronics, and motor hardware. To see the signals, use Data Inspector in the
Simulation tab of Simulink toolstrip. You can use this model to test the controller and explore its
expected behavior.

• Use the following command to open the model.

open_system('mcb_pmsm_foc_system.slx');
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NOTE: This model supports only floating-point computations.

• Run the simulation and see the logged speed reference and speed measured signals in the data
inspector.
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Explore Model Architecture

This section explains about the model architecture that includes:

• How the data is specified.

• How the controller is partitioned from the test bench.

• How controller is scheduled.

This architecture facilitates system simulation and algorithmic code generation.

A data definition file creates the data needed for simulation and code generation. This data file is
automatically run within the InitFcn callback of the system test bench model.

edit('mcb_algorithm_workflow_data.m')

Another data file "mcb_pmsm_foc_qep_f28069LaunchPad_data.m" defines the motor and inverter
parameters.

• Update the motor and inverter parameters for your hardware configuration in this file. For
example update motor parameters in the function mcb_SetPMSMMotorParameters that is called
from this file.
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Within the system test bench model, the embedded processor is modeled as a combination of the
peripherals and controller software. The block "mcb_pmsm_foc_system/Embedded Processor/Serial
Receive" implements the reference inputs for Simulation.

open_system('mcb_pmsm_foc_system/Embedded Processor');

We included the controller software in a separate model. This model contains the Speed Control and
Current Control subsystems of the FOC algorithm.

open_system('mcb_pmsm_foc.slx');
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The primary control law is a field-oriented controller. The controller has a low rate outer loop that
controls the speed. It also has a higher rate inner loop that controls the current. Speed Control
subsystem implements the speed PI controller. The Current Control subsystem converts the ADC
signals (or the current feedback) to per-unit values and passes them to the core controller algorithm.
In addition, it also measures speed and position values from the quardature encoder pulses.

The controller algorithm calculates the voltages. The voltages are then converted to a driver signal.
The Speed Controller outer loop executes after each instance of the "Current Control loop time
period." You can view the variables that specify these sample times:

fprintf('Current loop sample time = %f seconds\n', Ts)

fprintf('Speed loop sample time  = %f seconds\n', Ts_speed)

Generate Controller C Code for Integration into Embedded Application

This section instructs you to generate and visually inspect the C code function for the controller.

The generated code consists of these three generated global functions:

• void Controller_Init(void): This function should be called to perform initialization routines.

• void Current_Controller(void): This function implements the current controller and should be
called from a task running at 50e-6 seconds.

• void Speed_Controller(void): This function implements the speed controller and should be called
from a task running at 500e-6 seconds.

You can specify the function prototype in the Configure C Step Function Interface dialog box. For
more details, see Override Default C Step Function Interface.

Inputs:

• ExternalInputs_mcb_pmsm_foc: This is a structure with speed reference and motor enable signal.

• SensorSigs: This is an array with Ia ADC counts, Ib ADC counts, quadrature encoder position
counts and quadrature encoder index latch.

Outputs:

• PWM Duty: This is an array with PWM Duty Cycles for the three phases and the PWM enable
signal.

• DebugSignals: This is an array of signals that you can log while executing the control algorithm.

Parameters:

• PI_params: This is a structure which contains the PI gains Kp_i, Ki_i, Kp_speed, and Ki_speed.

• IsOffset, IbOffset: These are the data store variables that contain the ADC calibration offsets.

Hardware Peripheral Integration

• We integrated the hardware peripherals with the control algoithm inside the
"mcb_pmsm_foc_system/Embedded Processor" subsystem.

• The ADC interrupt is used to schedule the generated code. The interrupt triggers at 50e-6
seconds.
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• The subsystem "mcb_pmsm_foc_system/Embedded Processor/Hardware Init" finds the ADC
calibration offsets and provides them to the control algorithm.

• The subsystem "mcb_pmsm_foc_system/Embedded Processor/Sensor Driver Blocks" implements
the ADC and QEP peripherals.

• The subsystem "mcb_pmsm_foc_system/Embedded Processor/Serial Receive" has the serial blocks
to receive user inputs from a host model when the generated code is executing on the target.

• The subsystem "mcb_pmsm_foc_system/Embedded Processor/Inverter Driver Peripherals" has the
PWM driver peripherals and Serial Transmit block to send data to the host computer. All these
peripherals are used form the TI C2000 Support Package.

If you are using a custom processor, you can implement the driver logic using a hand written code.
You can integrate the generated code for the control algorithm with your own driver code in your
preferred IDE.

Test Behavior of Generated Code

For details of required hardware connections, see Hardware Connections.

• Find the QEP offset using this workflow.

• Build and load the executable file to the target for the model mcb_pmsm_foc_system.

• Open the host model "mcb_pmsm_foc_host_model_f28069m" using the link available in the
"mcb_pmsm_foc_system" model.

• Update the COM port name for the target in the Serial Configuration block.

• Start the simulation for the host model and change the switch position to Motor Start on
"mcb_pmsm_foc_host_model_f28069m/Manual Switch" to start running the motor.

• Change the Speed demand (RPM) and monitor the effects on the time scope.
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Run PMSM in Open-loop Control and Calibrate ADC Offset
Open-loop control (also known as Scalar control or Volts/Hz control) is a motor control technique that
varies the stator voltage and frequency to control the rotor speed. This is a simple technique that
does not need any feedback from the motor. A constant speed application of open-loop control uses a
fixed frequency motor power supply. Whereas, an adjustable speed application of open-loop control
needs a variable frequency power supply to control the rotor speed. To ensure a constant stator
magnetic flux, we keep the supply voltage amplitude proportional to its frequency.

This model runs the motor using an open-loop motor control algorithm. It helps you get started with
Motor Control Blockset and verify the hardware setup by running the motor. The target model also
reads the ADC values from the current sensors and sends it to the host model by using serial
communication.

Therefore, this model can be used to meet following objectives:

• Check connectivity with target.
• Check serial communication with target.
• Verify hardware and software environment.
• Check ADC Offsets for current sensors.
• Run a new motor with an inverter and target setup first time.

Supported Hardware
The target model supports the following hardware configurations:

F28069M control card configuration

• F28069M control card
• DRV8312-69M-KIT inverter
• BLY171D (motor that supports quadrature encoder)
• DC power supply (24V)

Note Due to a power supply related hardware problem, DRV8312-69M-KIT inverter does not support
Teknic M-2310P motor.

LAUNCHXL-F28069M configuration

• LAUNCHXL-F28069M controller
• BOOSTXL-DRV8301 and BOOSTXL-DRV8323 (supported inverters)
• Teknic motor M-2310P and BLY171D (motors that support quadrature encoder)
• DC power supply (24V)

LAUNCHXL-F28379D configuration

• LAUNCHXL-F28379D controller
• BOOSTXL-DRV8305 and BOOSTXL-3PHGANINV (supported inverters)
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• Teknic motor M-2310P and BLY171D (motors that support quadrature encoder)
• DC power supply (24V)

Hardware Connections
For F28069M control card configuration

1 Connect the F28069M control card to J1 of DRV8312-69M-KIT inverter board.
2 Connect the motor wires for three phases, to MOA, MOB, and MOC on the inverter board.
3 Connect the DC power supply (24V) to PVDDIN on the inverter board.
4 Attach the quadrature encoder sensor to the motor shaft.
5 Connect the quadrature encoder pins (G, I, A, 5V, B) to J4 on the inverter board.

For LAUNCHXL-F28069M and LAUNCHXL-F28379D configurations

1 Attach the BOOSTXL inverter board to J1, J2, J3, J4 on the LAUNCHXL controller board.
2 Connect the motor wires for three phases, to MOTA, MOTB, and MOTC on the BOOSTXL inverter

board.
3 Connect the DC power supply (24V) to PVDD and GND on the BOOSTXL inverter board.
4 Attach the quadrature encoder sensor to the motor shaft.
5 Connect the quadrature encoder pins (G, I, A, 5V, B) to QEP_A on the LAUNCHXL controller

board.

For more details regarding these connections, see “Hardware Connections” on page 8-2.

Required MathWorksProducts
• Motor Control Blockset
• Embedded Coder
• Embedded Coder Support Package for Texas Instruments C2000 Processors
• Fixed-Point Designer

Note For simulation, this model only needs Motor Control Blockset and Fixed-Point Designer.

Model
Use the following commands to open the target model:

• For a F28069M based controller:

open_system('mcb_open_loop_control_f28069M_DRV8312')
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• For a F28379 based controller:

open_system('mcb_open_loop_control_f28379d')
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Use the host model hyperlink available at the bottom-left area of the target models to open the host
model.
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The host model that runs on a host computer, receives the ADC current value from the target model
and displays the ADC counts in the scope. You can use the Manual Switch to either run or stop the
motor.

Pre-requisites for Running the Motor
1 Update the motor parameters in the model initialization script associated with the target model

and run the script. For instructions to update the script, see “Estimate Control Gains from Motor
Parameters” on page 3-2.

2 In the Serial Receive block mask of host model, select a Communication port value.
3 In the Serial Configuration block mask of host model, select a Baud rate value.
4 Load a sample program to CPU2 of LAUNCHXL-F28379D (for example, program that operates

the CPU2 blue LED using GPIO31) to ensure that CPU2 is not mistakenly configured to use the
board peripherals intended for CPU1.

Run Models to Implement Open-loop Control
1 Complete the hardware connections.
2 Configure the hardware settings (in Simulink) for the target model. For instructions, see “Model

Configuration Parameters” on page 2-2.
3 Click Build, Deploy & Start in the HARDWARE tab to deploy the target model to the

hardware.
4 Click the host model hyperlink in the target model to open the associated host model.
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5 Click Run in the SIMULATION tab to run the host model.
6 In the host model, change the Manual Switch position to Motor Start to start running the motor.
7 After the motor runs, open Time Scope in the host model to observe the ADC counts for the Ia

and Ib currents.

If the motor does not run, change the Manual Switch position to Motor Stop to stop the motor
and change the Speed demand (RPM) in the host model. Afterwards, change the Manual Switch
to Motor Start to run the motor again.

Run Models to Calibrate ADC Offset
1 Complete the hardware connections and configure hardware settings (in Simulink) for the target

model. For instructions, see “Model Configuration Parameters” on page 2-2.
2 Click Build, Deploy & Start in the HARDWARE tab to deploy the target model to the

hardware.
3 Click the host model hyperlink in the target model to open the associated host model.
4 Disconnect the motor wires for three phases, from the hardware board terminals.
5 Click Run in the SIMULATION tab to run the host model.
6 Open Time Scope in the host model to observe the ADC counts for the Ia and Ib currents. The

average values of the ADC counts are the ADC offset corrections for the currents Ia and Ib. You
can use these steps to obtain the average (median) values of ADC counts:

a In the Scope window, navigate to Tools > Measurements, and select the Signal Statistics
option to display the Trace Selection and Signal Statistics areas.
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b In the Trace Selection area select a signal (Ia or Ib). The window display the
characteristics of the selected signal in the Signal Statistics area. You can see the median
value of the selected signal in the Median field.
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Note This example supports simulation. Open the target model and click Run in the SIMULATION
tab to simulate the target model. On the target model, click Data Inspector in the SIMULATION
tab to view simulation results.

For the Motor Control Blockset examples, update the computed ADC (or current) offset value in the
model initialization script linked to the example. For instructions to update the script, see “Estimate
Control Gains from Motor Parameters” on page 3-2.

Also update the ADC offset value in the average model for the current sensor signal conditioning
circuits. For instructions to update the average model, see .
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Estimate Motor Parameters by Using Motor Control Blockset
Parameter Estimation Tool

Motor Control Blockset provides a parameter estimation tool that estimates the motor parameters
accurately. Use the estimated motor parameters to simulate the motor model and design the control
system. Therefore, the simulation response with the estimated parameters for the motor model is
close to the behavior of the motor under test.

The parameter estimation tool determines these motor parameters for a Permanent Magnet
Synchronous Motor:

• Phase resistance (Rs)
• d and q axis inductances (Ld and Lq)
• Back-EMF constant (Ke)
• Motor inertia (J)
• Friction constant (F)

The parameter estimation tool accepts the minimum required inputs, runs tests on the target
hardware, and displays the estimated parameters.

Pre-requisites
The parameter estimation tool needs the motor position detected by the Hall sensors. This requires
Hall sensor calibration for the motor under test.

• Ensure that the PMSM is in no-load condition.
• Ensure that the PMSM has Hall sensors.
• Calibrate the Hall sensor offset. For instructions, see “Hall Offset Calibration for PMSM Motor” on

page 4-39.

Supported Hardware
This example supports only the following hardware configurations:

F28069M control card configuration

• F28069M control card
• DRV8312-69M-KIT inverter
• A PMSM with Hall sensor
• DC power supply

Note The DRV8312-69M-KIT board has a known issue in the board's power supply section. Due to
this limitation, the board does not support all Hall sensor types. For example, it does not support the
Hall sensor of Teknic M-2310P motor.

LAUNCHXL-F28379D configuration
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• LAUNCHXL-F28379D controller
• BOOSTXL-DRV8305 inverter
• A PMSM with Hall sensor
• DC power supply

Required MathWorksProducts
You need these products to run the parameter estimation:

• Motor Control Blockset
• Fixed-Point Toolbox™

You need these optional products only to build the target models:

• Embedded Coder
• Embedded Coder Support Package for Texas Instruments C2000 Processors

Prepare Hardware
For F28069M control card configuration:

1 Connect the F28069M control card to J1 of DRV8312-69M-KIT inverter board.
2 Connect the motor three phases to MOA, MOB, and MOC on the inverter board.
3 Connect the DC power supply to PVDDIN on the inverter board.
4 Connect the Hall sensor encoder output to J10 on the inverter board.

For LAUNCHXL-F28379D configuration:

1 Attach the inverter board to the controller board such that J1, J2 of BOOSTXL aligns with J1, J2 of
LAUNCHXL.

2 Connect the motor three phases to MOTA, MOTB, and MOTC on the BOOSTXL inverter board.
3 Connect the DC power supply to PVDD and GND on the BOOSTXL inverter board.
4 Connect the Hall sensor output to QEP_B (configured as eCAP) on LAUNCHXL.

For more details regarding these connections, see “Hardware Connections” on page 8-2.

For more details regarding the model settings, see “Model Configuration Parameters” on page 2-2.

For LAUNCHXL-F28379D, load a sample program to CPU2, for example, program that operates the
CPU2 blue LED using GPIO31 (c28379D_cpu2_blink.slx) to ensure that CPU2 is not mistakenly
configured to use the board peripherals intended for CPU1.

Parameter Estimation Tool
The parameter estimation tool includes a target model and a host model. The models communicate
with each other by using a serial communication interface. For more details, see “Communication
between Host and Target” on page 7-2.
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Enter the system details about the motor under test in the host model. The target model uses an
algorithm to perform tests on the motor and estimate the motor parameters. The host model starts
these tests and displays the estimated parameters.

Prepare workspace
Use this MATLAB command to open the parameter estimation host model:

open_system('mcb_param_est_host_read.slx');

Enter these details in the host model to prepare the workspace:

• Board Selection - Select the target hardware and inverter combination.
• Communication Port - Specify the serial port that you want to configure. Select an available port

from the list. For more details, see “Find Communication Port” on page 7-4.
• Required Inputs - Enter these motor specification data. You can obtain these values either from

the motor datasheet or on the motor nameplate.

• Nominal Voltage - The rated voltage of the motor (Volts).
• Nominal Current - The rated current of the motor (Ampere).
• Nominal Speed - The rated speed of the motor (rpm).
• Pole Pairs - The number of pole pairs of the motor.
• Input DC Voltage - The DC supply voltage for the inverter (Volts).
• Hall Offset - The Hall sensor offset value (per-unit position) (see “Hall Offset Calibration for

PMSM Motor” on page 4-39 and “Per-Unit System” on page 7-15).
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In the Debug tab of the host model, click Update Model (Ctrl + D) to update the workspace with
the preceding inputs.

Note When updating Required Inputs, consider the following limitations:

• The rated speed of the motor must be less than 25000rpm.
• The tests protect the hardware from over-current faults. However, to ensure that these faults do

not occur, keep the motor's rated current (entered in Nominal Current field) less than the
maximum current supported by the inverter.

• If you have an SMPS based DC power supply unit, set a safe current limit on the power supply for
safety reasons.

Deploy Target Models
Before starting the tests by using the parameter estimation tool, you should download the binary files
(.hex/ .out) generated by the target model into the target hardware. There are two workflows to
download the binary files;

Workflow 1: Build and Deploy Target Model:

Use this workflow to generate and deploy the code for the target model. Ensure that you update the
workspace with the required input details from the host model.

Click one of these hyperlinks in the parameter estimation host model to open the target model (for
the hardware that you are using):

• For F28069M based controller:

mcb_param_est_f28069_DRV8312
• For F28379D based controller:

mcb_param_est_f28379D_DRV8305

Click Build, Deploy & Start in the HARDWARE tab to deploy the target model to the hardware.

Note Ignore the warning message "Multitask data store option in the Diagnostics page of the
Configuration Parameter Dialog is none" displayed by the model advisor, by clicking the Always
Ignore button. This is part of the intended workflow.
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Workflow 2: Manually Download Target Model:

Use this workflow to deploy the binary files (.hex/ .out) of the target model manually by using a third
party tool (the workflow does not need code-generation).

• Locate the binary files (.hex/ .out) at these locations:

• <matlabroot>\toolbox\mcb\mcbexamples\mcb_param_est_f28069_DRV8312.out
• <matlabroot>\toolbox\mcb\mcbexamples\mcb_param_est_f28379D_DRV8305.out

• Open a third-party tool to deploy the binary files (.hex/ .out).
• Download and run the binary files (.hex/ .out) on the target hardware.

Estimate Motor Parameters
Use the following steps to run the Motor Control Blockset parameter estimation tool:

1 Ensure that you deploy the binary files (.hex / .out) generated from the target model, to the
target hardware and update the required details in the host model.

2 In the host model, click Run in the Simulation tab to run the parameter estimation tests.
3 The parameter estimation process takes less than a minute to perform the tests. You can ignore

the beep sound produced during the tests.
4 The host model displays the estimated motor parameters after successfully completing the tests.

The tool uses the following algorithm to estimate parameters:

• Motor resistance (R) - The tool uses Ohm's law to estimate this value.
• Motor inductance (Ld and Lq) - The tool uses frequency injection method to estimate these values.
• Back EMF (Ke) - The tool measures the currents and voltages and uses the electric motor equation

to estimate this value.
• Permanent magnet flux (λ) - The tool uses the estimated back EMF constant to estimate this value.
• Friction constant (B) - The tool estimates this value by using the torque equation for a motor

running at a constant speed.
• Inertia (J) - The tool estimates this value by using retardation test.
• Rated Torque - The tool estimates this value by using the estimated value of permanent magnetic
flux of the motor.

During an emergency, you can manually turn the Run-Stop slider switch to Stop position to stop the
parameter estimation tests. In addition, the model interrupts the parameter estimation tests to
protect the hardware from the following faults:

1 Over-current fault
2 Under-voltage fault
3 Serial communication fault

Save Estimated Parameters
You can export the estimated motor parameters and further use them for the simulation and control
system design.
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To export, click Save Parameters to save the estimated parameters into a MAT (.mat) file.

To view the saved parameters, load the MAT (.mat) file in the MATLAB workspace. MATLAB saves the
parameters in a structure named 'motorParam' in the workspace.

Click Open Model to create a new Simulink model with a PMSM motor block. The motor block uses
the motorParam structure variables from the MATLAB workspace.
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Concepts

• “Communication between Host and Target” on page 7-2
• “Open-loop and Closed-loop Control” on page 7-8
• “Current Sensor ADC Offset and Position Sensor Calibration” on page 7-12
• “Per-Unit System” on page 7-15
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Communication between Host and Target
Motor Control Blockset uses a host model and target model communication interface to control the
motor and observe the feedback.

Host Model
The host model is a user interface for the controller hardware board. You can run the host model on
the host computer. The prerequisite to use the host model is to deploy the target model to the
controller hardware board.

The host model commands, controls, and exchanges data with the target hardware. You can perform
these operations using the host model available in the Motor Control Blockset:

• Find the serial communication port (COM port) in the host system. For more details, see "Find
Communication Port" section in this page.

• Configure the serial port and baud rate by using the Serial Setup block.
• Start or stop the motor.
• Specify the motor speed.
• View the debug or output signals that the host receives from the target, by using the Time Scope

and Display blocks.

Target Model
The target model runs on the controller hardware board. Deploy the target model to the embedded
target hardware that controls the motor. The target model communicates with the host model to
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receive commands from the user (for example, start or stop the motor). These are some common
operations that a target model available in Motor Control Blocksetperforms:

• Performs serial communication with the host model to receive the user commands and exchange
the binary data.

• Reads data from the position and current sensors attached to the motor and inverter.
• Controls the motor speed and torque by running the control algorithms and processing the

feedback.
• Generates the duty cycles inputs for the inverter.
• Enables fast serial data monitoring for debugging the signals.

Serial Communication Blocks
The host and target models interact with each other by using the following Motor Control Blockset
blocks that enable serial communication:

• Host Serial Receive
• Host Serial Setup
• Host Serial Transmit

Therefore, you can monitor, control, and customize the motor operation in real time. For example, you
can view the debug signals, stop or start the motor, and change the motor speed without repeated
deployment of the target model.

Fast Serial Data Monitoring
The Motor Control Blockset examples enable the fast serial data monitoring algorithm for performing
control and diagnostics through the host model. This algorithm enables you to observe data from the
target device at the same rate as the execution sample time (for example, PWM frequency of 20kHz).
This helps in diagnostics and analysis of the transients.

Evaluation boards often provide serial over USB connections that enable fast serial transfers. The
models running on the LaunchPad hardware boards, send signals like Ia and Ib currents over the
serial interface. Use the host model to receive these signals on your host computer. The Motor
Control Blockset examples that implement Field Oriented Control (FOC) for the F28379D LaunchPad
use mcb_pmsm_foc_host_model_f28379d.slx. Examples that implement FOC for F28069M targets, use
mcb_pmsm_foc_host_model_f28069m.slx. In addition, Motor Control Blockset provides other host
models for the application-based examples. Select the appropriate COM port that matches your
board, in the Serial Setup block of the host model.

Adjust the baud rate for your board:

• For F28027 LaunchPad, set the baud rate to 3.75e6.
• For F28069 LaunchPad, set the baud rate to 5.625e6.
• For F28377S LaunchPad, set the baud rate to 12e6.
• For F28379D LaunchPad, set the baud rate to 12e6.

After you deploy the target model to the target device, run the host model and observe the debug
signals updated at 20 kHz, on the time scope. You can use the same technique to monitor other
signals on other processors.
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Note SCI_A is usually connected to the FTDI chip that allow serial transfers over USB on the
LaunchPad boards, docking stations, and ISO control cards.

Find Communication Port
Use these steps to find the serial communication port in the Device Manager of Windows PC, after
you connect the target hardware to your system:

1 Open Device Manager on your Windows PC.
2 Look for an entry under Ports (COM & LPT) titled USB Serial Port (COMX), where X is a

number. You can note down this number to configure the serial setup block in the host model.

If you face difficulty in finding the COM port, follow these steps to determine the COM port:
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1 Open Device Manager on your Windows PC.
2 Look for an entry under Ports (COM & LPT) titled USB Serial Port (COMX), where X is a

number. If there are multiple COM ports, you can disconnect and reconnect the C2000 board and
observe the updates in Device Manager to determine the COM port.

3 Alternatively, follow these steps to determine the correct port name for the connected target
hardware:

a Right-click a communication port and click Properties.
b In the Details tab, select Hardware Ids property.
c If the port indicates the following IDs, the communication port belongs to the connected TI’s

C2000™ controller hardware board:

• VID: 0403
• PID: A6D0

4 If you do not see or find the right port in Ports (COM & LPT), navigate to Texas Instruments
Debug Probes and follow these steps:

a Right-click XDS100 Class Auxiliary Port Properties and select Properties. Navigate to
Advanced tab and select Load VCP.

b Right-click XDS100 Class Debug Port Properties and select Properties. Navigate to
Advanced tab and clear Load VCP.

c Disconnect and reconnect the USB cable to the system and observe the updates in Device
Manager to determine the COM port. The system now displays the COM port that belongs to
the connected TI’s C2000 controller hardware board.

Tip VCP stands for Virtual COM Port (for devices that support serial over USB communication).
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5 If Texas Instruments Debug Probes do not appear in the Device Manager, expand Universal
Serial Bus controllers in the Device Manager and follow these steps:

a Right-click TI XDS 100 Channel B and select Properties. Navigate to Advanced tab and
select Load VCP.

b Right-click TI XDS 100 Channel A and select Properties. Navigate to Advanced tab and
clear Load VCP.

c Disconnect and reconnect the USB cable to the system and observe the updates in Device
Manager to determine the COM port. The system now displays the COM port that belongs to
the connected TI’s C2000 controller hardware board.

6 If Device Manager does not detect the target hardware, follow these steps:

a Check that the target hardware is connected to the system.
b Check if the device drivers are installed correctly. Generally, device drivers are installed with

the Code Composer Studio™(CCS). Check if the CCS software is installed on your system.
Alternatively, try re-installing the device drivers suggested by Texas Instruments.

c Check if the serial connection cable is intact.
d If the problem persists, try connecting the hardware to another system and check if Device

Manager detects the hardware.
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e If you still face the problem, the target hardware may be faulty.
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Open-loop and Closed-loop Control
This section describes the open-loop and closed loop motor control techniques.

Open-Loop Motor Control
Open-loop control (also known as scalar control or Volts/Hz control) is a popular motor control
technique that you can use to run any ac motor. This is a simple technique that does not need any
feedback from the motor. To keep the stator magnetic flux constant, we keep the supply voltage
amplitude proportional to its frequency.

The preceding figure shows an open loop control. The power circuit consists of a PWM voltage fed
inverter supplied by a DC source. We do not use any feedback signal for control implementation. We
use the reference speed to determine the frequency of the stator voltages. We compute the voltage
magnitude as proportional to the ratio of rated voltage and rated frequency (commonly known as
Volts/Hz ratio), so that the flux remains constant.

λm ∝   Vs fs

where:

1 λm is the rated flux of the motor in Wb.
2 Vs is the stator voltage of the AC motor in Volts.
3 fs is the frequency of the stator voltage of the AC motor in Hz.

We can express the speed for an AC motor as:

Speed(rpm) =  
60 × fs

p

where:
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• Speed(rpm) is the mechanical speed of the AC motor in rpm.
• fs is the frequency of the stator voltage and currents of the AC motor in Hz.
• p is the number of pole pairs of the motor.

You can use the preceding expression to determine the frequency of reference voltages for a required
speed (for a given machine).

f ref =   p × RPMref
60

We use this frequency to generate PWM reference voltages for the inverter. We compute the
magnitude of voltages by maintaining Volts/Hz ratio as:

Vref =  
Vrated
frated

f ref

When using the per-unit system representation, we consider Vrated as the base quantity, which
usually corresponds to 1PU or 100% duty cycle. Depending on the modulation technique (either
Sinusoidal PWM or Space Vector PWM), you may need an additional gain ( 2

3  for sinusoidal PWM).

At lower speeds, we need a minimum boost voltage (15% or 25% of the rated voltage), to overcome
the effect of the stator resistance voltage drop.

You can use the open-loop control in the applications where the dynamic response is not a concern,
and a cost-effective solution is required. Open-loop motor control does not have the ability to consider
the external conditions that can affect the motor speed. Therefore, the control system cannot
automatically correct the deviation between the desired and the actual motor speed.

Note The scalar control implementation does not consider the compensation of voltage drop due to
the stator resistance and filed weakening.

Closed-Loop Motor Control
Closed-loop control considers the system feedback for control. The closed-loop control of the motor
considers feedback of the motor signals like current and position. The control system uses the
feedback signals to regulate the voltage (applied to the motor) to keep the motor response at a
reference value.
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Field-Oriented Control (FOC) (or vector control) is a popular closed-loop system that is used for
motor control applications. FOC is a technique that is used to implement closed-loop torque, speed,
and position control of motors. This technique also provides good control capability over the full
torque and speed ranges. The FOC implementation needs transformation of stator currents from the
stationary reference frame to rotor flux reference frame.

Speed control and torque control are the commonly used control modes of FOC. Whereas, the
position control mode is less common. Most of the traction applications use the torque control mode
in which the motor control system follows a reference torque value. In the speed control mode, the
motor controller follows a reference speed value and generates a torque reference for the torque
control that forms an inner subsystem. Whereas, in the position control mode, the speed controller
forms the inner subsystem.

You need real time feedback of the currents and rotor position to implement an FOC algorithm. You
can make the current and position measurements by using sensors. You can also use the sensorless
techniques that use the estimated feedback values instead of the actual sensor-based measurements.

Closed-loop control uses the real-time position and stator current feedback to tune the speed
controller and current controller and change the duty cycles of the inverter. Therefore, the corrected
three-phase voltage supply (that runs the motor) corrects the motor feedback deviation from the
desired value.

Open-Loop to Closed-Loop Transitions
Some applications require the motor to start with an open-loop control. Once the motor achieves the
minimum required stability in the open-loop, the control system shifts to closed-loop.

In a quadrature encoder-based position sensing system, the motor starts up in open-loop and
transitions to closed-loop once index pulse is detected.
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In a sensorless position control, the motor starts running at 10% of the base speed in the open-loop.
After the reference switch goes beyond 10% of base speed, the control system transitions from open-
loop to closed-loop.

To ensure smooth transition from open-loop to closed-loop, the PI controllers reset and start from the
initial condition same as the open loop outputs.
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Current Sensor ADC Offset and Position Sensor Calibration
This section explains about ADC and position sensor offset calibration.

Current Sensor ADC Offset Calibration
In an inverter, signal conditioning for the current sensor introduces an offset voltage in the ADC input
to measure both positive and negative current. This offset value is different for each target hardware
because it depends on the tolerances of the components in the signal sensing and conditioning
circuit. We recommend you to measure the current sensor ADC offset for the target hardware.
Current sensor ADC offset is represented in ADC counts that corresponds to zero ampere current.

See the example “Run PMSM in Open-loop Control and Calibrate ADC Offset” on page 5-2 to
manually measure the ADC offset value. In the Motor Control Blockset examples, update the
measured value in the inverter.CtSensAOffset and inverter.CtSensBOffset variables in the model
initialization scripts. This function updates the inverter.CtSensAOffset and inverter.CtSensBOffset
with the default values.

The examples in Motor Control Blockset calculate the current sensor ADC offset in the hardware
initialization subsystem. In the model initialization script, inverter.ADCOffsetCalibEnable = 1 enables
the current sensor offset calibration in the target hardware during initialization. In the hardware
initialization subsystem, ADC channels reads the input current multiple times and averages them.
The current controller uses this averaged ADC offset value. In the model initialization script,
inverter.ADCOffsetCalibEnable = 0 disables the current sensor offset calibration and uses the values
from the initialization script.

Note Always measure the current sensor ADC offset when the motor is not running. We recommend
you to unplug the electric wires connected to the motor.

Position Sensor Offset Calibration for Quadrature Encoder and Hall
Sensor
The controller requires the position sensor offset computation to determine an accurate real time
feedback of the rotor position, and therefore, implement the Field-Oriented Control (FOC) algorithm
correctly. We recommend that you use the examples for offset calibration to compute the position
offset before running any other example that uses FOC.

Hall sensor offset is the angle between the rotor’s d-axis and the position detected by the Hall sensor.
You can use the offset to correct and compute an accurate position of the rotor’s d-axis.

Quadrature encoder sensor offset is the angle between the rotor’s d-axis and encoder index pulse
position detected by the quadrature encoder.

Motor Control Blockset offers examples like and to obtain the accurate rotor position for
implementing the control algorithm. The offset computation examples use a unique algorithm along
with open-loop control to compute the position offsets of the position sensors (Hall or quadrature
encoder). Open-loop control (also known as scalar control or volt/Hz control) is a popular motor
control technique that can be used to run any AC motor. This is a simple technique that does not need
any feedback from the motor. To ensure a constant stator magnetic flux, we keep the supply voltage
amplitude proportional to its frequency. The following figure shows an overview of the open-loop
control. See “Open-loop and Closed-loop Control” on page 7-8 for more details.
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By the using this algorithm, the offset calibration examples detect the position offset:

• Check if the motor is in a no-load condition.
• Start and run the motor in open-loop at a very low speed (for example, 60rpm). At a low speed, the

rotor d-axis closely aligns with rotating magnetic field of the stator.
• Measure the feedback position of the available position sensor (Hall or quadrature encoder).
• Compare the open-loop position with feedback position and check that the phase-sequence is

correct. If required, correct the motor phase-sequence.
• Compute the Hall sensor position offset by obtaining the difference between the open-loop

position and feedback position.
• Run the motor in the open-loop for few cycles and stop the motor. Ensure that the encoder index

pulse is detected at least once. Lock the rotor in d-axis. The quadrature encoder position offset is
same as the position feedback. This outputs the quadrature encoder mechanical offset position.
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The preceding figure shows the comparison of open-loop position from control algorithm along with
the actual position of the motor. The figure also shows the feedback from the position sensor. The
position offset, which is the difference between the open-loop position and feedback position from
sensor, is computed by the algorithm provided in the offset calibration models.

• Update the measured offset in ‘pmsm.PositionOffset’ variable in model initialization script of the
examples.

• For parameter estimation, update the measured Hall offset in the Hall Offset field of
"mcb_param_est_host_read" model.

Note The example outputs the electrical position offset. Whereas, the example outputs the
mechanical position offset.

For steps to compute the offsets, see these examples:

“Run PMSM in Open-loop Control and Calibrate ADC Offset” on page 5-2
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Per-Unit System
Motor Control Blockset uses these International System of Units (SI):

Quantity Unit Symbol
Voltage volt V
Current ampere A
Speed radians per second

revolutions per minute

rad/s

rpm
Torque newton-meter N.m
Power watt W

Note The SI Unit for speed is rad/s. However, most manufacturers use rpm as the unit to specify the
rotational speed of the motors. Therefore, Motor Control Blockset prefers rpm as the unit of
rotational speed over rad/s. However, you can use either one based on your preference.

What is Per-Unit System
The Per-Unit (PU) system is commonly used in electrical engineering to express the values of
quantities like voltage, current, power, and so on. It is used for transformers and AC machines for
power system analysis. Embedded systems engineers also use this system for optimized code-
generation and scalability, especially when working with fixed-point targets.

For a given quantity (such as voltage, current, power, speed, and torque), the PU system expresses a
value in terms of a base quantity:

quantity expressed in PU = quantity expressed in SI units
base value

Generally, we select the nominal values of a system as the base values. Sometimes, we may also
select the maximum measurable value as the base value. Thereafter, all signals are represented in PU,
with respect to the selected base value.

For example, in a motor-control system, if the selected base value for current is 10A, then the PU
representation of the 2A current is expressed as (2/10) PU = 0.2 PU.

Similarly,

quantity expressed in SI units = quantity expressed in PU × base value

For the preceding example, the SI unit representation of 0.2 PU = (0.2 x base value) = (0.2 x 10) A.

Per-Unit System and Motor Control Blockset
Motor Control Blockset uses these conventions to define the base values for voltage, current, speed,
torque, and power.
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Quantity Representation Convention
Base voltage Vbase This is the maximum phase

voltage supplied by the inverter.

Generally, it is
PU_System.V_base = 
inverter.V_dc

3

 for Space

Vector PWM and
PU_System.I_base = inverter.I_max
for Sinusoidal PWM.

Base current Ibase This is the maximum current
that can be measured by the
ADC connected to the inverter.

Generally, but not necessarily, it
is Imax of the inverter.

Base speed Nbase This is the nominal (or rated)
speed of the motor. This is also
the maximum speed that the
motor can achieve at the
nominal voltage and nominal
load without field-weakening
operation.

Base torque Tbase This is torque that is
mathematically derived at the
base current. Physically, the
motor may or may not be able to
produce this torque.

Generally, it is
PU_System.T_base = 32
× pmsm.p × pmsm.FluxPM

× PU_System.I_base

.

Base power Pbase This is the power derived by the
base voltage and base current.

Generally, it is
PU_System.P_base = 32
× PU_System.V_base

× PU_System.I_base

.

where:
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• Vdc is the DC voltage that you provide to the inverter.
• Imax is the maximum current measured by the ADCs connected to the current sensors of the

inverter.
• p is the number of pole pairs available in the PMSM.
• λpm is the permanent magnet flux linkage of the PMSM.

For the voltage and current values, you can generally consider the peak value of the nominal
sinusoidal voltage (or current) as 1PU. Therefore, the base values used for voltage and current are
the RMS values multiplied by 2, or the peak value measured between phase-neutral.

By using the PU system, the calculations are simplified. Motor Control Blockset uses these base value
definitions for the PU system related conversions performed by the algorithms used in the examples.
It stores the preceding variables in a structure called “PU_System” in the MATLAB workspace.

Why Use Per-Unit System Instead of Standard SI Units
Per-unit representation of signals has many advantages over the SI units. This technique:

• Improves the computational efficiency of the code-execution, and therefore, it is a preferred
system to use for the fixed-point targets.

• Creates a scalable control algorithm across many systems.
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Hardware Connections

• “Hardware Connections” on page 8-2
• “Dual Motor (Dyno) Control for PMSM” on page 8-13
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Hardware Connections
Motor Control Blockset supports the following hardware configurations:

1 F28069 control card configuration
2 LAUNCHXL-F28069M configuration
3 LAUNCHXL-F28379D configuration
4 C2000 MCU Resolver Eval Kit [R2]

F28069 control card configuration
The configuration includes the following hardware components:

• Texas InstrumentsDRV8312-69M-KIT inverter board
• Texas Instruments F28069 microcontroller control card
• Motor BLY171D (supports both Hall and quadrature encoder sensors)
• Motor BLY172S (supports Hall sensor)
• Quadrature encoder
• DC power supply

Note Due to auxiliary power supply related hardware issues, the DRV8312-69M-KIT does not support
the position sensors connected to some motors (for example, Teknic M-2310P motor).

The following steps describe the hardware connections for the F28069 control card configuration:

1 Connect the F28069 control card to J1 of DRV8312-69M-KIT inverter board.
2 Connect the motor three phases, to MOA, MOB, and MOC on the inverter board.
3 Connect the DC power supply (24V) to PVDDIN on the inverter board.

Warning Be careful when connecting PVDD and GND to the positive and negative connections of the
DC power supply. A reverse connection can damage the hardware components.
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The following step describes about interfacing the quadrature encoder sensor:

• Connect the quadrature encoder pins (G, I, A, 5V, B) to J4 on the inverter board.

To implement position-sensing by using Hall sensor, use a motor that has inbuilt Hall sensors (for
example, BLY171D and BLY172S). The following steps describe the steps to interface the Hall sensor:

• Connect the Hall sensor encoder output to J10 on the inverter board.

 Hardware Connections
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We recommend the following jumper settings for DRV8312-69M-KIT inverter board when working
with Motor Control Blockset. You can customize these settings depending on the application
requirements. For more information about these settings, see the device user guide available on
Texas Instruments website.

• JP1 – VR1
• JP2 – ON
• JP3 – OFF
• JP4 – OFF
• JP5 – OFF
• M1 – H
• J2 – OFF
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• J3 – OFF
• RSTA – MCU
• RSTB - MCU
• RSTC - MCU

LAUNCHXL-F28069M and LAUNCHXL-F28379D configurations
The LAUNCHXL-F28069M configuration includes the following hardware components:

• LAUNCHXL-F28069M controller
• BOOSTXL-DRV8305 (supported inverter)
• Teknic motor M-2310P (supports both Hall and quadrature encoder sensors)
• Motor BLY171D (supports both Hall and quadrature encoder sensors)
• Motor BLY172S (supports Hall sensor)
• DC power supply

The LAUNCHXL-F28379D configuration includes the following hardware components:

• LAUNCHXL-F28379D controller
• BOOSTXL-DRV8305 and BOOSTXL-3PHGANINV (supported inverters)
• Teknic motor M-2310P (supports both Hall and quadrature encoder sensors)
• Motor BLY171D (supports both Hall and quadrature encoder sensors)
• Motor BLY172S (supports Hall sensor)
• DC power supply

The following steps describe the hardware connections for the LAUNCHXL-F28069M and
LAUNCHXL-F28379D configurations:

1 Attach the BOOSTXL inverter board to J1, J2, J3, J4 on the LAUNCHXL controller board.

Note Attach the inverter board to the controller board such that J1, J2 of BOOSTXL aligns with
J1, J2 of LAUNCHXL.

2 Connect the motor three phases, to MOTA, MOTB, and MOTC on the BOOSTXL inverter board.
3 Connect the DC power supply (24V) to PVDD and GND on the BOOSTXL inverter board.

Warning Be careful when connecting PVDD and GND to the positive and negative connections of the
DC power supply. A reverse connection can damage the hardware components.
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The following step describes about interfacing the quadrature encoder sensor:

• Connect the quadrature encoder pins (G, I, A, 5V, B) to QEP_A on the LAUNCHXL controller
board.

To implement position-sensing by using Hall sensor, use a motor that has inbuilt Hall sensors (for
example, Teknic motor M-2310P, BLY171D and BLY172S). The following steps describe the steps to
interface the Hall sensor:

• Connect the Hall sensor encoder output to a GPIO port that is configured as eCAP, on the
LAUNCHXL controller board.
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We recommend the following jumper settings for the LAUNCHXL inverter boards when working with
Motor Control Blockset. You can customize these settings depending on the application requirements.
For more information about these settings, see the device user guide available on Texas Instruments
website.

For LAUNCHXL-F28069M controller

• JP1 – ON
• JP2 – ON
• JP3 – ON
• JP4 – ON
• JP5 – ON
• JP6 – OFF
• JP7 – ON

For LAUNCHXL-F28379D controller

• JP1 – ON
• JP2 – ON
• JP3 – ON
• JP4 – ON
• JP5 – ON
• JP6 – OFF

8 Hardware Connections
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Instructions for Dyno (Dual Motor) Setup

1 Connect the three phases of Motor1 and Motor2, to MOTA, MOTB, and MOTC on the
corresponding BOOSTXL inverter boards.

2 Attach the BOOSTXL inverter board (connected to Motor1) to J1, J2, J3, J4 on the LAUNCHXL
controller board.

Note Attach the inverter board to the controller board such that J1, J2 of BOOSTXL aligns with
J1, J2 of LAUNCHXL.

3 Attach the BOOSTXL inverter board (connected to Motor2) to J5, J6, J7, J8 on the LAUNCHXL
controller board.

Note Attach the inverter board to the controller board such that J1, J2 of BOOSTXL aligns with
J5, J6 of LAUNCHXL.

4 Connect the DC power supply (24V) to PVDD and GND on both BOOSTXL inverter boards.

Note Connect the PVDD and GND on the BOOSTXL boards (for MOTOR1 and MOTOR2) to the
same power supply. When one motor consumes power, the second motor generates power. If you
connect both motors to the same power supply, the power generated by one motor is consumed
by the other motor. The DC power supply delivers power only for the losses.

5 Connect the quadrature encoder pins of Motor1 (G, I, A, 5V, B) to QEP_A on the LAUNCHXL
controller board.

6 Connect the quadrature encoder pins of Motor2 (G, I, A, 5V, B) to QEP_B on the LAUNCHXL
controller board.

Warning Be careful when connecting PVDD and GND to the positive and negative connections of the
DC power supply. A reverse connection can damage the hardware components.
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C2000 MCU Resolver Eval Kit [R2]
The C2000 MCU Resolver Eval Kit [R2] configuration includes the following hardware components:

• LAUNCHXL-F28069M controller
• BOOSTXL-DRV8305 (supported inverter)

8 Hardware Connections
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• DC power supply
• C2000 MCU Resolver Eval Kit [R2]
• Resolver encoder

The following steps describe the hardware connections for the MCU Resolver Eval Kit [R2] board:

1 Connect DC power supply (15V) to J2 on the MCU Resolver Eval Kit board.
2 Connect the resolver output pins for sine wave to pins 1, 2 of J10 on the MCU Resolver Eval Kit

board.
3 Connect the resolver output pins for cosine wave to pins 3, 4 of J10 on the MCU Resolver Eval Kit

board.
4 Connect the resolver input pins to the PWM_dither and PWM_SINE pins of J10 on the C2000™

MCU Resolver Eval Kit board.

The following step describes the hardware connection for the LAUNCHXL-F28069M controller board:

• Connect the LAUNCHXL-F28069M controller board to a computer via USB port.

The following steps describe the hardware connections between the MCU Resolver Eval Kit [R2] and
LAUNCHXL-F28069M controller boards:

1 Connect the COS(T2) pin on MCU Resolver Eval Kit [R2] to pin 24 of J3 on the LAUNCHXL-
F28069M controller board.

2 Connect the SIN(T8) pin on MCU Resolver Eval Kit [R2] to pin 29 of J3 on the LAUNCHXL-
F28069M controller board.

3 Connect the GPIO2 pin on MCU Resolver Eval Kit [R2] to pin 38 of J4 on the LAUNCHXL-
F28069M controller board.

 Hardware Connections
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Dual Motor (Dyno) Control for PMSM
This example implements the Field-Oriented Control (FOC) technique to control two three-phase
Permanent Magnet Synchronous Motor (PMSM) motors coupled together in a dyno setup. Motor1
runs in the closed-loop speed control mode. Motor2 runs in the torque control mode and loads Motor
1 because they are mechanically coupled. You can use this example to test a motor in different load
conditions.

The example simulates two motors that are connected back-to-back. You can use a different speed
reference for Motor1 and different torque reference or current reference (Iq) for Motor2. Motor1
runs at the reference speed for the load conditions provided by Motor2 (with different current
reference).

The example runs in the controller hardware board. You can input the speed reference for Motor1
and current reference for Motor2 using a host model. The host model uses serial communication to
communicate with the controller hardware board.

Current control loops in Motor1 and Motor2 control algorithms are offset by Ts/2, where Ts is the
control-loop execution rate.

Models

The example includes this model:

• mcb_pmsm_foc_f28379d_dyno

You can use this model for both simulation and code generation. You can use the "open_system"
command to open the Simulink® model. For example, use this command for a F28379D based
controller:

open_system('mcb_pmsm_foc_f28379d_dyno.slx');

 Dual Motor (Dyno) Control for PMSM
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Required MathWorks® Products

To simulate model:

• Motor Control Blockset™

To generate code and deploy model:

• Motor Control Blockset™
• Embedded Coder®
• Embedded Coder® Support Package for Texas Instruments™ C2000™ Processors
• Fixed-Point Designer™ (only needed for optimized code generation)

Prerequisites

1. Obtain the motor parameters for both Motor1 and Motor2. We provide default motor parameters
with the Simulink® model that you can replace with the values from either the motor datasheet or
other sources.

However, if you have the motor control hardware, you can estimate the parameters for the motor that
you want to use, by using the Motor Control Blockset™ parameter estimation tool. For instructions ,
see “Estimate Motor Parameters by Using Motor Control Blockset Parameter Estimation Tool” on
page 6-2..

2. Update the motor parameters (that you obtained from the datasheet, other sources, or parameter
estimation tool) and inverter parameters in the model initialization script associated with the
Simulink® model. For instructions to update the script, see “Estimate Control Gains from Motor
Parameters” on page 3-2.

For this example, update the motor parameters for both the motors in the model initialization script.
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Simulate Model

This example supports simulation. Follow these steps to simulate the model.

1. Open a model included with this example.

2. Click Run in the Simulation tab to simulate the model.

3. Click Data Inspector in the Simulation tab to view and analyze the simulation results.

4. Input a different speed reference for Motor1 and a different current reference (load) for Motor2.
Observe the measured speed and other logged signals in the Data Inspector.

Generate Code and Deploy Model to Target Hardware

This section instructs you to generate code and run the FOC algorithm on the target hardware.

The example uses a host and a target model. The host model is a user interface to the controller
hardware board. You can run the host model on the host computer. The pre requisite to use the host
model is to deploy the target model to the controller hardware board. The host model uses serial
communication to command the target Simulink® model and run the motor in a closed-loop control.

Required Hardware

The example supports this hardware configuration. Use the target model name (highlighted in bold)
to open the model for the corresponding hardware configuration, from the MATLAB® command
prompt.

• LAUNCHXL-F28379D controller + 2 BOOSTXL-DRV8305 inverters:
mcb_pmsm_foc_f28379d_dyno

For connections related to the preceding hardware configuration, see “Instructions for Dyno (Dual
Motor) Setup” on page 8-9.

Generate Code and Run Model on Target Hardware

1. Simulate the target model and observe the simulation results.

2. Complete the hardware connections.

3. The model automatically computes the ADC (or current) offset values. To disable this functionality
(enabled by default), update the value 0 to the variable inverter.ADCOffsetCalibEnable in the model
initialization script.

Alternatively, you can compute the ADC offset values and update it manually in the model
initialization scripts. For instructions to compute the ADC offset, see “Run 3-Phase AC Motors in
Open-loop Control and Calibrate ADC Offset” on page 4-52.

4. Compute the quadrature encoder index offset value and update it in the model initialization scripts
associated with the target model. For instructions to compute the quadrature encoder offset, see
“Quadrature Encoder Offset Calibration for PMSM Motor” on page 4-45.

For this example, update the QEP offset values in the pmsm_motor1.PositionOffset and
pmsm_motor2.PositionOffset variables in initialization script.
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5. Open the target model. If you want to change the default hardware configuration settings for the
model, see “Model Configuration Parameters” on page 2-2.

6. Load a sample program to CPU2 of LAUNCHXL-F28379D, for example, program that operates the
CPU2 blue LED by using GPIO31 (c28379D_cpu2_blink.slx), to ensure that CPU2 is not mistakenly
configured to use the board peripherals intended for CPU1.

7. Click Build, Deploy & Start in the Hardware tab to deploy the model to the hardware.

8. Click the host model hyperlink in the target model to open the associated host model. You can
also use the "open_system" command to open the host model:

open_system('mcb_pmsm_foc_host_model_dyno.slx');
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9. In the Host Serial Setup block mask of the host model, select a Port name.

10. Click Run in the Simulation tab to run the host model.

11. Change the Start / Stop Motor 1 switch position to On, to start running the motor.

12. Update the Reference Speed for Motor1 and Current Reference for Motor2 in the host model.

13. Select the debug signals that you want to monitor, to observe them in the Time Scope of host
model.
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